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Notice
While reasonable efforts have been made to ensure that the 
information in this document is complete and accurate at the time 
of printing, Avaya assumes no liability for any errors. Avaya reserves 
the right to make changes and corrections to the information in this 
document without the obligation to notify any person or organization 
of such changes.
Documentation disclaimer
“Documentation” means information published in varying media 
which may include product information, subscription or service 
descriptions, operating instructions and performance specifications 
that are generally made available to users of products. 
Documentation does not include marketing materials. Avaya shall 
not be responsible for any modifications, additions, or deletions 
to the original published version of Documentation unless such 
modifications, additions, or deletions were performed by or on the 
express behalf of Avaya. End user agrees to indemnify and hold 
harmless Avaya, Avaya's agents, servants and employees against 
all claims, lawsuits, demands and judgments arising out of, or in 
connection with, subsequent modifications, additions or deletions to 
this documentation, to the extent made by End user.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked 
websites referenced within this site or Documentation provided by 
Avaya. Avaya is not responsible for the accuracy of any information, 
statement or content provided on these sites and does not 
necessarily endorse the products, services, or information described 
or offered within them. Avaya does not guarantee that these links will 
work all the time and has no control over the availability of the linked 
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software. 
Please refer to your agreement with Avaya to establish the terms of 
the limited warranty. In addition, Avaya’s standard warranty language 
as well as information regarding support for this product while under 
warranty is available to Avaya customers and other parties through 
the Avaya Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link 
“Warranty & Product Lifecycle” or such successor site as designated 
by Avaya. Please note that if the product(s) was purchased from an 
authorized Avaya channel partner outside of the United States and 
Canada, the warranty is provided by said Avaya Channel Partner and 
not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that 
You acquire from either Avaya or an authorized Avaya Channel 
Partner (as applicable) and which is described further in Hosted SAS 
or other service description documentation regarding the applicable 
hosted service. If You purchase a Hosted Service subscription, 
the foregoing limited warranty may not apply but You may be 
entitled to support services in connection with the Hosted Service 
as described further in your service description documents for the 
applicable Hosted Service. Contact Avaya or Avaya Channel Partner 
(as applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN 
AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR 
AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS 
OF USE FOR HOSTED SERVICES ARE AVAILABLE ON THE 
AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO 
UNDER THE LINK “Avaya Terms of Use for Hosted Services” 
OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND 
ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES THE 
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED 
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON 
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE 
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY 
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. 
IF YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A 
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT 
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE 

TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, 
OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF 
USE, YOU MUST NOT ACCESS OR USE THE HOSTED SERVICE 
OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED 
SERVICE.
Licenses
The Global Software License Terms (“Software License Terms”) 
are available on the following website https://www.avaya.com/en/
legal-license-terms/ or any successor site as designated by Avaya. 
These Software License Terms are applicable to anyone who 
installs, downloads, and/or uses Software and/or Documentation. By 
installing, downloading or using the Software, or authorizing others to 
do so, the end user agrees that the Software License Terms create 
a binding contract between them and Avaya. In case the end user is 
accepting these Software License Terms on behalf of a company or 
other legal entity, the end user represents that it has the authority to 
bind such entity to these Software License Terms.
Copyright
Except where expressly stated otherwise, no use should be made 
of materials on this site, the Documentation, Software, Hosted 
Service, or hardware provided by Avaya. All content on this site, the 
documentation, Hosted Service, and the product provided by Avaya 
including the selection, arrangement and design of the content is 
owned either by Avaya or its licensors and is protected by copyright 
and other intellectual property laws including the sui generis rights 
relating to the protection of databases. You may not modify, copy, 
reproduce, republish, upload, post, transmit or distribute in any way 
any content, in whole or in part, including any code and software 
unless expressly authorized by Avaya. Unauthorized reproduction, 
transmission, dissemination, storage, or use without the express 
written consent of Avaya can be a criminal, as well as a civil offense 
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine. 
Each product has its own ordering code and license types. Unless 
otherwise stated, each Instance of a product must be separately 
licensed and ordered. For example, if the end user customer or 
Avaya Channel Partner would like to install two Instances of the 
same type of products, then two products of that type must be 
ordered.
Third Party Components
The following applies only if the H.264 (AVC) codec is distributed 
with the product. THIS PRODUCT IS LICENSED UNDER THE AVC 
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A 
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, 
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL 
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR 
EMBED THE H.264 CODEC OR H.265 CODEC, THE AVAYA 
CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE 
AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND 
ALL RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) 
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL USE OF A CONSUMER 
OR OTHER USES IN WHICH IT DOES NOT RECEIVE 
REMUNERATION TO: (i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC 
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO 
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE 
IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) 
CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
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Compliance with Laws
You acknowledge and agree that it is Your responsibility to comply 
with any applicable laws and regulations, including, but not limited 
to laws and regulations related to call recording, data privacy, 
intellectual property, trade secret, fraud, and music performance 
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications 
system by an unauthorized party (for example, a person who is not a 
corporate employee, agent, subcontractor, or is not working on your 
company's behalf). Be aware that there can be a risk of Toll Fraud 
associated with your system and that, if Toll Fraud occurs, it can 
result in substantial additional charges for your telecommunications 
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You 
need technical assistance or support, please contact your Avaya 
Sales Representative.
Security Vulnerabilities
Information about Avaya’s security support policies can be 
found in the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled 
per the Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this 
site, the Documentation, Hosted Service(s), and product(s) provided 
by Avaya are the registered or unregistered Marks of Avaya, its 
affiliates, its licensors, its suppliers, or other third parties. Users 
are not permitted to use such Marks without prior written consent 
from Avaya or such third party which may own the Mark. Nothing 
contained in this site, the Documentation, Hosted Service(s) and 
product(s) should be construed as granting, by implication, estoppel, 
or otherwise, any license or right in and to the Marks without the 
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya LLC.
All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and 
other countries.
Downloading Documentation
For the most current versions of Documentation, see the Avaya 
Support website: https://support.avaya.com, or such successor site 
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for 
Product or Cloud Service notices and articles, or to report a 
problem with your Avaya Product or Cloud Service. For a list of 
support telephone numbers and contact addresses, go to the Avaya 
Support website: https://support.avaya.com (or such successor site 
as designated by Avaya), scroll to the bottom of the page, and select 
Contact Avaya Support.
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Chapter 1: Introduction

Purpose
This document describes how to generate performance management reports for Avaya Aura®

Contact Center.

Intended audience
This document is intended for people who want to learn how to use the reporting features in Avaya 
Aura® Contact Center.

Related resources

Avaya Aura® Contact Center documentation
The following table lists the documents related to Avaya Aura® Contact Center. Download the 
documents from the Avaya Support website at https://support.avaya.com.

Title Document purpose Audience
Overview

Table continues…
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Title Document purpose Audience
Avaya Aura® Contact Center 
Overview and Specification

This document provides the 
high-level technical details you 
need to set up your Contact 
Center suite. The document 
contains background planning and 
engineering information, including 
server preparation information, routing 
options, licensing configurations, and 
hardware configuration information. 
It also contains the background 
information you require to install all 
software components that are part of 
and work with Contact Center. General 
information about considerations for 
upgrading your existing Contact 
Center is also included. This document 
contains strategies and requirements 
to plan your network configuration 
and prepare your servers for Contact 
Center software installations.

Customers and sales, 
services, and support 
personnel

Avaya Aura® Contact 
Center and Avaya Aura®

Unified Communications Solution 
Description

This document describes the solution 
architecture, suggested topologies, 
and capacities for the Avaya 
Aura® Unified Communications (UC) 
platform. This document also 
describes the features and functional 
limitations of certain configurations.

Customers and sales, 
services, and support 
personnel

Avaya Aura® Contact Center and 
Avaya Communication Server 1000 
Solution Description

This document describes the solution 
architecture, suggested topologies, 
and capacities for the Avaya 
Communication Server 1000 platform. 
This document also describes the 
features and functional limitations of 
certain configurations.

Customers and sales, 
services, and support 
personnel

Avaya Aura® Contact Center 
Documentation Catalog

This document contains high-level 
information about Avaya Aura®

Contact Center documentation 
resources and the type of information 
in each document.

Customers and sales, 
services, and support 
personnel

Avaya Aura® Contact Center 
Terminology

This document contains definitions for 
the technical terms specific to Contact 
Center.

Customers and sales, 
services, and support 
personnel

Contact Center Performance 
Management Data Dictionary

This document contains reference 
tables that describe statistics and 
data in historical and real-time reports 
generated in Contact Center.

System administrators 
and contact center 
supervisors

Table continues…

Introduction
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Title Document purpose Audience
Implementing
Avaya Aura® Contact Center 
and Avaya Aura® Unified 
Communications Integration

This document contains information 
and procedures to integrate the Avaya 
Aura® UC platform with Contact 
Center.

Implementation personnel

Avaya Aura® Contact Center and 
Avaya Communication Server 1000 
Integration

This document contains information 
and procedures to integrate the Avaya 
Communication Server 1000 platform 
with Contact Center.

Implementation personnel

Deploying Avaya Aura® Contact 
Center DVD for Avaya Aura® Unified 
Communications

This document contains information 
about Contact Center DVD installation, 
initial configuration, and verification for 
the Avaya Aura® UC platform.

Implementation personnel

Deploying Avaya Aura® Contact 
Center DVD for Avaya 
Communication Server 1000

This document contains information 
about Contact Center DVD installation, 
initial configuration, and verification 
for the Avaya Communication Server 
1000 platform.

Implementation personnel

Deploying Avaya Aura® Contact 
Center Software Appliance 
for Avaya Aura® Unified 
Communications

This document describes how to 
deploy the Avaya Aura® Contact 
Center Software Appliance for the 
Avaya Aura® UC platform.

Implementation personnel

Avaya Aura® Contact Center 
Commissioning for Avaya Aura®

Unified Communications

This document describes Contact 
Center preparation, initial 
configuration, and verification of the 
installation on the Avaya Aura® UC 
platform.

Implementation personnel

Avaya Aura® Contact Center 
Commissioning for Avaya 
Communication Server 1000

This document describes Contact 
Center preparation, initial 
configuration, and verification of 
the installation on the Avaya 
Communication Server 1000 platform.

Implementation personnel

Avaya Aura® Contact Center 
and Proactive Outreach Manager 
Integration

This document provides conceptual 
and procedural information on the 
integration between Avaya Aura®

Contact Center (AACC) and Avaya 
Proactive Outreach Manager (POM). It 
describes the tasks required for AACC 
and POM integration.

Implementation personnel

Upgrading and Patching Avaya 
Aura® Contact Center

This document contains information 
and procedures to upgrade from 
previous releases to Contact 
Center, migrating the databases, 
and information and procedures to 
download and install service packs.

Implementation personnel 
and system administrators

Table continues…

Related resources
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Title Document purpose Audience
Administering
Avaya Aura® Contact Center Server 
Administration

This document contains information 
and procedures for day-to-day 
maintenance of all servers in the 
Contact Center suite, including server 
maintenance tasks, administrative 
tasks, managing data, configuring 
data routing, performing archives, and 
backing up data. It also describes 
optional configuration procedures.

System administrators

Avaya Aura® Contact Center Client 
Administration

This document contains information 
and procedures to configure users 
and user access, skillsets, server 
management, and configuration data 
in the Contact Center database.

System administrators 
and contact center 
supervisors

Using Contact Center Orchestration 
Designer

This document contains information 
and procedures to configure script 
and flow applications in Orchestration 
Designer.

System administrators

Maintaining
Maintaining Avaya Aura® Contact 
Center

This document contains routine 
maintenance procedures, such 
as installing service packs and 
maintaining the databases for the 
Contact Center system.

System administrators 
and support personnel

Troubleshooting Avaya Aura®

Contact Center
This document contains system-
wide troubleshooting information and 
procedures for Contact Center 
hardware, software, and network.

System administrators 
and support personnel

Contact Center Event Codes This Microsoft Excel spreadsheet 
contains a list of errors in the Contact 
Center suite and recommendations to 
resolve them.

System administrators 
and support personnel

Using
Using Avaya Aura® Contact Center 
Reports and Displays

This document contains procedures to 
generate performance reports, and to 
monitor and analyze performance data 
and performance measurements.

System administrators 
and contact center 
supervisors

Using Agent Desktop for Avaya 
Aura® Contact Center 

This document provides information 
and procedures for agents who use 
the Agent Desktop application to 
accept, manage, and close contacts of 
all media types in Contact Center.

Contact center agents 
and supervisors

Table continues…
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Title Document purpose Audience
Using the Contact Center Agent 
Browser application

This document provides information 
and procedures for agents who use 
the Agent Browser application to log 
on to Contact Center and perform 
basic tasks.

Contact center agents

Using Avaya Workspaces for AACC 
and ACCS

This document describes the tasks 
that Contact Center agents can 
perform using Avaya Workspaces.

Contact center agents 
and supervisors

Release Notes
Avaya Aura® Contact Center 
Release Notes

The Release Notes contain information 
about known issues, patches, and 
workarounds.

System administrators 
and support personnel

Finding documents on the Avaya Support website
Procedure

1. Go to https://support.avaya.com.

2. To log in, click Sign In at the top of the screen and then enter your login credentials when 
prompted.

3. Click Product Support > Documents.

4. In Search Product, start typing the product name and then select the appropriate product 
from the list displayed.

5. In Select Release, select the appropriate release number.

This field is not available if there is only one release for the product.

6. (Optional) In Enter Keyword, type keywords for your search.

7. From the Select Content Type list, select one or more content types.

For example, if you only want to see user guides, click User Guides in the Select Content 
Type list.

8. Click  to display the search results.

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot 
Avaya products.

Related resources
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About this task
Videos are available on the Avaya Support website, listed under the video document type, and on 
the Avaya-run channel on YouTube.

• To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of 
the following:

- In Search, type Avaya Mentor Videos, click Clear All and select Video in the Select 
Content Type.

- In Search, type the product name. On the Search Results page, click Clear All and select 
Video in the Select Content Type.

The Video content type is displayed only when videos are available for that product.

In the right pane, the page displays a list of available videos.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do 
one of the following:

- Enter a keyword or keywords in the Search Channel to search for a specific product or 
topic.

- Scroll down Playlists, and click a topic name to see the list of videos available. For 
example, Contact Centers.

Note:

Videos are not available for all products.

Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date 
documentation, product notices, and knowledge articles. You can also search for release notes, 
downloads, and resolutions to issues. Use the online service request system to create a service 
request. Chat with live agents to get answers to questions, or request an agent to connect you to a 
support team if an issue requires additional expertise.

Introduction
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Chapter 2: Changes in this release

The following sections detail what is new in Using Avaya Aura® Contact Center Reports and 
Displays Release 7.1.x.

Features
This section provides high-level information about new features. There are no new features for this 
document in other 7.1.x releases.

New features in the Release 7.1 base build
See the following section for information about new features in the Release 7.1 base build: Video 
contacts on page 15.

New features in Release 7.1.2 Service Pack 2
Release 7.1.2.2 introduces new Avaya Workspaces features. For more information about these 
features, see Avaya Workspaces features for Release 7.1.2.2 on page 15.

New features in Release 7.1.2.2.25
Release 7.1.2.2.25 introduces new Avaya Workspaces features. For more information about these 
features, see Avaya Workspaces patch update for Release 7.1.2.2 on page 16.

Video contacts
From Release 7.1, Contact Center supports routed video contacts. Contact Center supports both 
skillset and non-skillset video contacts. Video contacts are reported on in both real-time and 
historical reports. You can view video calls using Avaya Workplace Client or Avaya Vantage™, but 
you must use Avaya Agent Desktop or Avaya Workspaces for call control actions.

To support video contacts, your solution must include Avaya Aura® Web Gateway 3.3 or later.

Avaya Workspaces features for Release 7.1.2.2
Release 7.1.2.2 introduces the following Avaya Workspaces features for Avaya Aura® Contact 
Center (AACC) and Avaya Contact Center Select (ACCS). For more information about Avaya 
Workspaces features, see Using Avaya Workspaces for AACC and ACCS.
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Consult, transfer, and conference options for web chat
You can consult with another agent during a chat interaction. Messages between agents are 
whispered so the customer does not see them.
If the other agent agrees, you can do one of the following when ending the consultation:

• Transfer the web chat to the other agent.
• Start a conference.

Observe web chat
A supervisor can observe a chat interaction from the My Agents widget.

Whisper coaching during web chat
While observing a chat interaction, the supervisor can start coaching. During the coaching 
session, the supervisor can whisper guidance to the agent. The customer does not see whispered 
messages.

Barge in to web chat
A supervisor can barge in to the chat interaction and communicate with the customer directly.

Email approval
A supervisor can approve or reject an email and add review comments. The agent can edit the 
email and add comments if it is rejected.

Reschedule email
You can postpone work on an email and reschedule it for a later time. This is a useful option if you 
need more time to gather information before completing the email.

Email transfer enhancements and new forwarding option
Previously, you could only transfer an email interaction to a skillset. Now, you can also transfer the 
email to another agent. In addition, you can also forward an email to any email address.

Multiple keyword search
You can use multiple keywords when searching through email templates and suggested content.

Customer history view
Customer history information for all contact types (voice and multimedia) is now displayed 
together in the same table.

Avaya Workspaces patch update for Release 7.1.2.2
Release 7.1.2.2.25 provides the following Avaya Workspaces update for Avaya Aura® Contact 
Center (AACC) and Avaya Contact Center Select (ACCS). For more information about Avaya 
Workspaces features, see Using Avaya Workspaces for AACC and ACCS.

High Availability (HA) support for Avaya Workspaces cc-ccs-adapter service
The Avaya Workspaces cc-ccs-adapter service supports High Availability (HA) starting from Avaya 
Contact Center Workspaces Release 7.1.2.2.25. This feature enables two instances of the cc-

Changes in this release
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ccs-adapter service to run simultaneously in the production environment to ensure continuous 
operation.

• One instance functions as the active service, responsible for managing all workspace user 
activities, including agents and super agents.

• The other instance acts as a standby service, continuously monitoring the health of the active 
instance.

If the active service instance fails for any reason, the standby service instance automatically takes 
over, restoring all users to their previous states and resuming operations with minimal downtime 
proportional to the number of agents needed to be restored.
When the failover occurs, the new active cc-ccs-adapter instance does the following:

• Restores all agent sessions and maintains application continuity.
• Restores web chat interactions.
• Restores email templates.
• Ensures uninterrupted call handling by restoring voice call sessions.

Other changes in previous releases
This section outlines key changes in Release 7.1.2.2. There are no other changes for this 
document in previous 7.1.x releases.

Other changes in Release 7.1.2.2
Release 7.1.2.2 includes the following other changes:

• End of support for Internet Explorer on page 17
• Windows operating system support on page 18
• Interoperability with Avaya Workplace Client and Avaya Workplace VDI Client on page 18

For more detailed information about interoperability and other changes, see Avaya Aura® Contact 
Center Overview and Specification.

End of support for Internet Explorer
Microsoft ended support for the Internet Explorer (IE) web browser in June 2022.
Many Contact Center applications, such as Contact Center Manager Administration (CCMA), 
Contact Center Multimedia (CCMM), and Communication Control Toolkit (CCT) require the IE 
engine. To run these applications, you must use Microsoft Edge in IE mode. If you are using 
Windows 10, IE can be disabled but cannot be removed from your computer. With Windows 11, 
you do not need to install the IE browser because Edge already includes the IE engine.

Other changes in previous releases
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Windows operating system support
The following Microsoft operating systems are no longer supported:

• Windows 7 and 8.1

• Windows Server 2012 R2 and earlier versions

See the Microsoft website for lifecycle policy information.

Interoperability with Avaya Workplace Client and Avaya 
Workplace VDI Client

Contact Center supports interoperability with:

• Avaya Workplace Client Release 3.34 and later

• Avaya Workplace VDI Release 3.0 SP10 and later

Changes in this release
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Chapter 3: Performance management 
fundamentals

This section provides an overview of performance management reporting tools and utilities.

Filters
In Avaya Aura® Contact Center, you can create filters for real-time and historical reporting. 
Historical Reporting filters can be assigned to the Network Consolidated historical reports only. 
Each Historical Reporting filter can contain only one of the following types of data:

• skillsets

• applications

• route numbers

• route names

• DNIS numbers

• DNIS names

For Real-time Reporting, you can configure skillset, application, and agent filters. You can also 
configure filters with a combination of the three data types.

Use filters to specify the skillset, application, and agent data that you want to see in the real-time 
displays. In the Filters window, configure the filters from all elements in the partition assigned to 
you. After configuring filters, you can assign the filters to your private real-time displays.

The real-time displays show subtotals of data for each filter, which are further divided into 
subtotals for each site that belongs to the filter. For network consolidated real-time displays, the 
system calculates the network total for each of the two types of statistics:

• for raw statistics, such as the number of calls answered, the network total is the sum of all 
filter subtotals.

• for calculated statistics, such as the average answer delay, the network total is the amount 
reached after applying the appropriate formula to the sum of all individual statistics in the 
column. The system does not use the subtotal values in this calculation.
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Note:

Some statistical fields cannot be accumulated.

With the filters feature you select the sites and site resources to include in a network consolidated 
report, for example, the Network Consolidated Skillset Performance Report. After you create a 
filter, you can include the filters whenever you generate a report. You can create multiple filters, by 
selecting different sets of sites and resources for reporting.

Thresholds
You can assign threshold alerts to real-time and graphical displays. Assign colors to threshold 
settings to highlight text when a threshold level is exceeded.

You can define threshold values for system activity. These values result in three operational levels:

• Below level 1: Based on the type of statistic, this level can mean normal contact center 
operation and no action required (that is, the lower the number of calls waiting, the better), 
or it can signify an alert situation that requires attention (that is, the lower the service level 
percentage, the worse the situation).

• Between level 1 and level 2: This level can indicate a required action to prevent contact 
center performance to move beyond acceptable operating levels.

• Above level 2: Based on the type of statistic, this level can mean normal contact center 
operation and no action required (that is, the higher the service level percentage, the better), 
or it can signify an alert situation that requires attention (that is, the greater the number of 
calls waiting, the worse the situation).

Historical statistics
Use the Historical Reporting component to generate reports detailing the past performance of a 
contact center. In the Historical Reporting window, you can select the server in Contact Center 
Manager Server from which you want to run and schedule performance, configuration, and 
network reports (if you work in a networked environment). These reports can help you to monitor 
system performance by providing information about system activity.

You must have Historical Statistics access to configure the Historical statistics. You can configure 
historical statistics collection options, such as the values for general system parameters, the types 
of call flow, agent, and Interactive Voice Response (IVR) historical statistics to be collected, and 
the applications for which call-by-call data gets collected.

Performance management fundamentals
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Real-time statistics
The Contact Center Manager Administration Real-Time Reporting displays provide up-to-date 
statistics for your contact center and resources. You can view changes in call activity in real time, 
such as the number of calls waiting to be answered, the number of agents assigned to each 
skillset, and the number of abandoned calls.

You must have Real-Time Statistics access to configure these statistics. You can configure 
collection options, the data collection interval, and the minimum refresh rate. Network-
consolidated and Nodal are the two types of real-time statistics available.

Network-consolidated displays
You can view the network-consolidated displays only if you have the networking feature enabled 
and you have access to a Network Control Center (NCC) server. These displays provide an 
overall, real-time view of contact center activities across a network linked by multiple servers in 
Contact Center Manager Server.

Nodal displays
Nodal displays provide a real-time view of contact center activities for a specific contact center.

Access and partition management
Contact Center Manager Administration (CCMA) includes four main components that help 
administrators control the data that users can access in the contact center. The administrator 
can use these components to tailor access rights to suit every user in the contact center. The 
following four components are available:

• basic access rights to each component in Contact Center Manager Administration

• partitions

• supervisor-reporting agent combinations

• access classes

The first level of security is the overall right to access the applications within Contact Center 
Manager Administration. When an administrator defines Contact Center Manager Administration 
users in Access and Partition Management, the administrator specifies the applications that the 
user can access from the CCMA Launchpad.

The next level of security involves partitions, supervisor-reporting agent combinations, and access 
classes. The administrator can use partitions and supervisor-reporting agent combinations to 
specify the data that Contact Center Manager Administration users can view and manage. 
The administrator can use access classes to control the actions that users can perform in 
Contact Center Manager Administration Management, Scripting, Historical Reporting, Real-Time 
Reporting, and Configuration components.

Real-time statistics
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Chapter 4: Filter management

Use this feature to do the following:

• Specify the agent that AACC must display on the agent map graphical displays.

• Apply filters on the real-time display grids and the agent map graphical displays to see specific 
skill sets, applications, and agents in real-time.

Note:

To use this feature, do the following:

• Have the necessary permissions and credentials to access the filters.

• Do not log in with the credentials of a web administrator.

Creating a filter in real-time reporting
About this task
Create filters to specify the skillsets, applications, and agents that you want to see in the real-time 
display grids, and the agents that you want to see in the agent map graphical displays.

Before you begin
• Log on to real-time reporting.
• Ensure that you have access to filters.

Procedure
1. On the Filters menu, click Manage Filters.

2. Right-click the Filters folder and then click Add Filter.
3. In the New Filter Name field, type a filter name.

You can use only alphanumeric characters. Do not use special characters.

4. Click Submit to save the filter.
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Creating filter in Historical reporting
About this task
You must configure networking in each of the Contact Center Manager Server (CCMS) servers 
for the Historical Reporting application to list all CCMS servers. Create and use the filters in the 
Historical Reporting application for Network Consolidated reports.

Before you begin
Log on to Historical Reporting.

Procedure
1. From the Filters menu, click Manage Filters.

2. Click Add Filter.
3. In the New Filter Name field, type a filter name.

You can use only alphanumeric characters. Do not use special characters.

4. Click Submit.
5. Select the required resource.

6. Click Submit.

Adding skillset elements to a filter
About this task
Add skillset elements to a filter to view statistics.

Before you begin
• Log on to Real-Time Reporting or Historical Reporting.
• Create at least one filter.
• Ensure that you have access to filters.

Procedure
1. On the Filters menu, click Manage Filters.

2. In the left pane, select the filter to edit.

3. Select the Contact Center Manager Server on which to add the elements.

4. On the Skillsets tab, click the Assign Skillsets heading.

5. From the list, select contains, is equal to, or start with.

6. Type the skillset name.

7. Click Search.

Creating filter in Historical reporting
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8. In the list of available skillsets, do one of the following:

• Select the check box for each skillset you want to add to the filter.

• To select all skillsets, select the Select All check box.

9. Click Submit to save your changes.

Adding application elements
About this task
When you select an application element to filter in billboards and charts, your new application 
element appears in the Filter Selection list under Available.

Before you begin
• Log on to Real-Time Reporting or Historical Reporting.
• Create at least one filter.
• Ensure that you have access to filters.

Procedure
1. On the Filters menu, click Manage Filters.

2. Select the Application tab.

3. In the list of available applications, do one of the following:

• To add to a filter, select check box for each application.

• To choose all available applications, select the Select All check box.

4. Click Submit.

Adding agent elements to a filter
About this task
Add agent elements to include statistics for specific agents.
When you select an application element to filter in billboards and charts, the new application 
element displays in the Filter Selection list under Available.

Before you begin
• Log on to Real-Time Reporting.

Note:
You cannot add agents to a Historical Reporting filter.

Filter management
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• Create at least one filter.
• Ensure that you have access to filters.

Procedure
1. On the Filters menu, click Manage Filters.

2. In the left pane, select the filter to edit.

3. Select the Contact Center Manager Server on which to add the elements.

4. On the Agents tab, click the Assign Agents heading.

5. From the list, select one of the following:

• Last Name
• First Name
• Department
• Comment
• Login ID

6. From the second list, select contains, is equal to, or start with.

7. In the Search field, type a value.

You can search for up to five levels by selecting And or Or from the last list.

8. Click Search.

Agents that match your criteria are displayed in a table.

9. In the list of available agents, do one of the following:

• Select the check box for each agent you want to add to the filter.

• To choose all available agents, select the Select All check box.

10. Click Submit to save your changes.

Removing elements
About this task
To modify the report display, you must remove elements from a filter.

Before you begin
• Log on to Real-Time Reporting or Historical Reporting.
• Create at least one filter.
• Ensure that you have access to filters.

Removing elements
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Procedure
1. On the Filters menu, click Manage Filters.

2. In the left pane, select the filter to remove applications, skillsets, or agents.

3. Clear the check boxes for each skillset, application, or agent.

4. Click Submit.

Deleting a filter
About this task
To rename a filter, you must delete the filter and create a new one with a new name.

Before you begin
• Log on to Real-Time Reporting or Historical Reporting.
• Create at least one filter.
• Ensure that you have access to filters.

Procedure
1. On the Filters menu, click Manage Filters.

2. In the left pane, select the filter to delete.

3. In the right pane, click Delete Filter.

The application displays the confirmation dialog box.

4. Click OK.

Applying filters to real-time tabular displays
About this task
Use the Filters page to apply filters to customize your real-time tabular displays. You can apply a 
filter, a supervisor-reporting agent combination, or both.

Before you begin
• Log on to Real-Time Reporting or Historical Reporting.
• Create at least one filter.
• Ensure that you are logged on as a standard Contact Center Manager Administration user.

Procedure
1. In the left pane, under the server containing the real-time display, select the Private 

Tabular Displays folder.

Filter management
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2. Click the private display to customize.

3. Click the Filters tab.

4. From the list of available filters, do one of the following:

• To assign filters to the real-time display, select the corresponding check boxes.

• To assign all available filters, click Select All.
5. Click Submit.
6. Click Launch Display to view the changes.

Applying filters to graphical displays
About this task
With filters on Real-Time displays, supervisor can group agents, applications, or skillsets. The 
Real-Time reporting provides summary of statistics for filters. Filters are available for selection as 
an alternative to skillsets or applications on Real-Time reporting billboards and charts.
The following displays support filters:

• Application Billboards
• Skillset Billboards
• Application Chart (statistics per application)
• Skillset Chart (statistics per skillset)
• Time Line Chart (statistics per skillset)
• Time Line Chart (statistics per application)
• Agent Map

Note:
Dashboard displays do not support filters.

Before you begin
• Log on to Real-Time Reporting or Historical Reporting.
• Create at least one filter.
• Ensure that you have access to filters.
• Ensure that you are logged on as a standard Contact Center Manager Administration user.

Procedure
1. In the left pane, under the server containing the real-time graphical display to which you 

require to apply filters, select the Private Tabular Displays folder.

2. Click a private display to customize.

Applying filters to graphical displays
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3. From the Applications or Skillsets drop-down list, select a filter.

The filters are grouped at the end of the Applications or Skillsets list.

4. Click Submit.
5. Click Launch Display to view the changes.

Applying supervisor-reporting agent combinations to real-
time displays

About this task
You can apply supervisor-reporting agent combinations to the Standard Agent display.

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

Procedure
1. In the left pane, select the server containing the Standard Agent real-time display.

2. Select the Private Tabular Displays folder.

3. Click the private agent display to customize.

4. Click the Filters tab.

5. From the list of available supervisor-reporting agent combinations, do one of the following:

• Select the check box for each supervisor you want to assign to the real-time display.

• To assign all available supervisor-reporting agent combinations and filters, select the 
Select All check box.

6. Click Submit to save your changes.

7. Click Launch Display to start the display and view your changes.

Removing filters from a real-time display
About this task
You can remove filters you do not require to modify a real-time display.

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one filter.

Filter management
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Procedure
1. In the left pane, select the server that contains the real-time display.

2. Select the Private Tabular Displays folder.

3. Click the display to customize.

4. Click the Filters tab.

5. From the list of assigned filters, do one of the following:

• Clear the check box for each filter you want to remove from the real-time display.

• To remove all filters, select the Clear All check box.

6. Click Submit to save your changes.

Removing filters from a real-time display
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Chapter 5: Real-time reporting

The Contact Center Manager Administration (CCMA) Real-Time Reporting displays provide up-to-
date statistics for your contact center and resources. With access to statistics that update in real-
time, such as the number of contacts waiting to be answered, the number of agents assigned to 
each skillset, and the number of abandoned calls, you can view changes in contact activity as they 
occur.

If you use Agent Desktop Displays from CCMA, the status of an agent is different for each display.

Prerequisites to real-time reports
Ensure that you have access to the Real-Time Reporting (RTR) component and associated 
access class elements.

Logging on to Real-Time reporting
Before you begin

• Ensure that you have access to Real-Time Reporting.

About this task
To access Real-Time Reporting, log on to the Real-Time Reporting component in Contact Center 
Manager Administration.

Procedure
1. Log on to Contact Center Manager Administration.

Contact Center Manager Administration (CCMA) displays the date and time of your last 
login and also the number of failed login attempts before a successful login.

2. On the Launchpad, click Real-Time Reporting.

The Real-Time Reporting window appears.
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Creating a private real-time display
Before you begin

• Create a copy of a public display template. See Making a public copy of a private real-time 
display on page 31.

• Log on to real-time reporting.

About this task
Create a private real-time display to customize real-time displays.
For more information about customizing real-time displays. See Real-time report customization on 
page 67.

Procedure
1. In the left pane, click the server on which to create a private real-time display.

2. Select the Public Tabular Displays folder.

3. From the expanded Public Tabular Displays folder, select the display to copy.

4. In the Public Display window, type the name of your new private display. You can use only 
alphanumeric characters in the display name; do not use special characters.

When you copy a display, the system gives the new display a default name in the format 
[server name]_[display name]. Since each private display must have a unique 
name, you must type a new name, if you save a public display with the same default name. 
If you do not type a new name, the system overwrites the existing display.

5. To save the display in the Private Tabular Displays folder, click Make Private Copy.

6. On the Properties page, you can change the colors, font size, and the refresh rate.

Making a public copy of a private real-time display
About this task
After you customize a real-time display and save it in your Private Tabular Displays folder, you 
can share the display with other users by making a public copy. You can copy the display to 
the Public Tabular Displays folder on the currently selected server or across all servers on the 
network to which you have access.

Important:
Contact Center saves filters only for private real-time displays. Contact Center does not save 
filters on public copies of your private real-time displays. Supervisors and agents using public 
copies can apply filters when they view the displays, but Contact Center does not save these 
filters on the public copy.

Creating a private real-time display
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For information about making public copies of graphical displays, see Making a public copy of 
a graphical display on page 49 or Creating a public collection or public billboard collection on 
page 63.

Procedure
1. Log on to the Real-Time Reporting component.

2. In the left pane, click the Contact Center Manager Server on which to create a public copy 
of a private real-time display.

3. Select the Private Tabular Displays folder.

4. From the expanded Private Tabular Displays folder, select the display to copy.

5. At the bottom of the Properties page, type the name of the display as you want it to appear 
in the Public Tabular Displays folder.

Note:

You can use only alphanumeric characters in the display name; do not use special 
characters. You cannot type the same name used by one of the Standard Public 
displays as you cannot overwrite these displays. If you type the same name as an 
existing copied display, then you overwrite the existing display.

6. Select the servers on which you want the public copy of your private display to appear. You 
can choose the current server on which you save the private display or all servers to which 
you have access.

If you have access to an NCC server and you copy a nodal display across all servers, you 
do not see the nodal display on the NCC server. You can copy nodal real-time displays 
to every server on the network except the NCC server. Likewise, you can copy private 
network-consolidated displays to the Public Tabular Displays folder only on the NCC 
server (that is, you cannot copy these displays across all servers in the network).

7. Click Make Public Copy to save the private display in the Public Tabular Displays folder.

8. In the Public Display window, you can view the public display, make a new private copy of 
it, or, if you are an administrator logged on as webadmin, you can delete the display.

Deleting public displays
Before you begin

• Ensure that you log on to Contact Center Manager Administration as the webadmin 
administrator.

• Log on to real-time reporting.

About this task
If required, you can delete custom public displays. You cannot delete standard public displays (the 
displays that come with the Contact Center Manager Administration software).

Real-time reporting
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Procedure
1. In the left pane, navigate to the public display to delete.

2. In the Public Display window, click Delete Public Display.

3. In the message box that asks you to confirm your choice, click OK.

Note:

The same public display can exist on multiple servers, if the user who saved it chose to 
copy it to all servers on the network. If you delete the display on one server, you do not 
delete all copies.

Applying custom formulas to real-time displays
About this task
After you create custom formulas in the Formula Editor, apply them to your private real-time 
displays in the Real-Time Reporting component.
You can customize only the columns in private displays. If you choose a public display, you must 
first copy and save it in your Private Displays folder before you can customize the columns. See 
Creating a private real-time display on page 31.

Procedure
1. In the Real-Time Reporting main window, select the Private Tabular Displays folder under 

the server containing the display to customize.

2. Click the display to customize.

3. Click the Columns tab.

4. From the Available Fields list, select the formula to add to the real-time display.

5. Click Add Field.

6. Click Submit to save your changes.

7. Click Launch Display to view your changes.

Starting a network summary
About this task
You can start a performance summary chart in bar format for all sites in the network (if you work 
in a networked environment). The chart updates at the same refresh rate as the real-time display 
grid.

Applying custom formulas to real-time displays
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Procedure
1. Log on to Real-Time Reporting.

2. In the left pane, click the NCC server.

3. Navigate to the network summary chart.

4. Click Network Summary.

The chart appears approximately after a 5-second delay.

Printing a summary chart
Before you begin

• Ensure that a NCC server is available.

About this task
If you require a hard copy, you can print a summary chart.

Procedure
1. Log on to Real-Time Reporting.

2. In the left pane, click the server on which the summary chart is stored.

3. Navigate to the summary chart.

4. Click Print.
5. In the Print dialog box, select the printer you want to use.

To view the summary chart in color, select a color printer.

6. Click OK.

Printing a real-time display
About this task
If you require a hard copy, you can print a real-time display.

Procedure
1. Log on to Real-Time Reporting.

2. In the left pane, click the server on which the real-time display is stored.

3. Navigate to the real-time display and click Launch Display.

4. Click Print.

Real-time reporting
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5. In the Print dialog box, select the printer you want to use.

6. Click Print.

Deleting a private display
Before you begin

• At least one private display must exist.

About this task
Delete private tabular displays and private graphical displays.

Note:
Once you delete a display, you cannot recover it.

Procedure
1. Log on to the Real-Time Reporting component.

2. In the left pane, click the server that contains the private display to delete.

3. Click the Private Tabular Displays folder to delete a private tabular display.

OR

Click the Private Graphical Displays folder to delete a private graphical display.

4. In the selected folder, click the private display to delete.

5. In the right pane, click Remove Private Display to delete a private tabular display.

OR

Click Remove Display to delete a private graphical display.

6. In the Confirmation dialog box, click OK.

The system permanently deletes the display.

Deleting an exported real-time display grid
About this task
You can delete real-time display grids from the Contact Center Manager Administration server that 
you export as HTML files.

Important:
You must carefully manage exported displays. Exported displays consume disk space on the 
Contact Center Manager Administration server.

Deleting a private display
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Procedure
1. Log on to the Real-Time Reporting component.

2. From the Displays menu, click Manage Exported Displays.
3. In the right pane, select the check box for each exported file to delete.

OR

To delete all files, click Select All.
4. Click Delete to remove the selected files from the Contact Center Manager Administration 

server.

Logging out an agent from a real-time display
Before you begin

• Log on to CCMA. For more information, see Logging on to Real-Time reporting on page 30.
• Ensure you have an Access Class that allows you to force agent state changes.
• Customize a private real-time display to include the Log Out column, or select a display 

customized by another user. For more information, see Real-time report customization on 
page 67.

About this task
Use this procedure to log out an agent from a real-time display.

Procedure
1. In the left pane, select an Agent Display that has the Logout column and shows the agent 

you want to log out.

2. In the right pane, click Launch Display.

CCMA opens the real-time display window.

3. Scroll to the agent that you want to log out.

4. Click the Force Log out button ( ).

5. On the Logout Confirmation dialog, click Yes.

Contact Center logs out the agent, and displays a message on the agent’s Agent Desktop 
interface informing them that a supervisor has logged them out.

Real-time reporting
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Changing an agent’s Ready status from a real-time display
Before you begin

• Log on to CCMA. For more information, see Logging on to Real-Time reporting on page 30.
• Ensure you have an Access Class that allows you to force agent state changes.
• Customize a private real-time display to include the Change State column, or select a display 

customized by another user. For more information, see Real-time report customization on 
page 67.

About this task
Use this procedure to change an agent’s status from a real-time display.

Procedure
1. In the left pane, select an Agent Display that has the Change State column and shows the 

agent whose status you want to change.

2. In the right pane, click Launch Display.

CCMA opens the real-time display window.

3. Scroll to the agent for whom you want to change the ready status.

4. Click the Change State button ( / ).

CCMA displays the Change Agent State dialog.

5. If you changed the agent’s status from Ready to Not Ready, on the Change Agent State 
dialog, enter a Not Ready Reason code, and click Yes.

Contact Center displays a message on the agent’s Agent Desktop interface informing them 
of the state change.

6. If you changed the agent’s status from Not Ready to Ready, on the Change Agent State 
dialog click Yes.

Contact Center displays a message on the agent’s Agent Desktop interface informing them 
of the state change.

Viewing the non-staffed skillsets
About this task
Use the Non-Staffed Skillsets window to view a list of all the skillsets within your partition, without 
logged-on agents. The list of non-staffed skillsets automatically refreshes every 20 seconds with 
the most recent information.

Procedure
1. Log on to the Real-Time Reporting component.

Changing an agent’s Ready status from a real-time display
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2. In the left pane, click the relevant server and then click the folder that contains the skillset 
display.

3. Click the skillset display that you want to launch.

4. In the right pane click Launch Display

The display launches.

5. In the display, click Non-Staffed Skillsets.

The Non-Staffed Skillsets window appears, listing all of the skillsets within your partition, 
without logged-on agents.

Real-time reporting
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Chapter 6: Exported displays

The procedures in this section describe how to work with exported real-time displays.

Prerequisites to exported displays
Ensure that you have access to the Real-Time Reporting (RTR) component and associated 
access class elements.

Exporting summary charts
Before you begin

• Log on to real-time reporting.

About this task
You can export site summary charts as a bitmap or a jpeg file.

Procedure
1. In the left pane, under the relevant server, click the folder that contains the display.

2. In the expanded list, click the desired real-time display or chart graphical display.

3. In the right pane, click Launch Display.

4. On the real-time display, click [site name] Summary to view the real-time display site 
summary chart.

5. If you view a site summary from a network consolidated real-time display, in the Site 
column, click the desired site name

6. On the summary chart, click Export BMP.

OR

Click Export JPG.

A message box appears with the name of the exported file and the export time.
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For example, if you export the Agent display site summary chart for the Winnipeg 
site as a .bmp file on June 29, 2000 at 2:23 p.m., the exported file name is 
StandardAgent_Winnipeg_20000629_142307.bmp.

7. Click OK.

Exporting network summary charts
Before you begin

• Log on to real-time reporting.
• Ensure that you have an NCC server.

About this task
You can export network summary charts as a bitmap or a jpeg file.

Procedure
1. In the left pane, under the Network Control Center (NCC) server, open the desired public 

or private network consolidated real-time display.

2. From the display, click Network Summary.

3. On the network summary chart, click Export BMP.

OR

Click Export JPG.

A message box shows the exported file name and the export time. For example, if 
you export the Network Consolidated Agent Position Status Count network summary 
chart as a .bmp file on June 29, 2000 at 2:23 p.m., the exported file name is 
Ntwk_AgentPositionCount_20000629_142307.bmp.

4. Click OK.

Viewing an exported real-time display
Before you begin

• Log on to real-time reporting.
• Ensure that you are using the Microsoft Edge browser in Internet Explorer mode.

About this task
You must view an exported real-time display to print the display.

Exported displays
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Procedure
1. From the Displays menu, select Manage Exported Displays.

2. In the right pane, from the list of HTML files, click the name of the file to view.

Your browser displays a snapshot of the real-time display grid.

3. In your Microsoft Edge browser, click ... > Print to print the exported grid.

Ensure that you select a color printer to view the colored rows of the real-time display.

Exporting real-time display grids
Before you begin

• Log on to real-time reporting.
• Ensure that you are using the Microsoft Edge browser in Internet Explorer mode.

About this task
You can export real-time displays to open the file in a new browser window. Exporting real-time 
displays creates a snapshot file in the HTML format.

Important:
You must carefully manage exported displays. Exported displays consume disk space on the 
Contact Center Manager Administration server.

Procedure
1. In the left pane, double-click the real-time display grid to export.

2. On the real-time display grid, click Export.
3. To open the file in a new web browser window, click View.

Changing the file name prefix of exported real-time display 
grids

Before you begin
• Log on to real-time reporting.

About this task
You can choose the prefix to appear in the file name when you export the real-time display grids to 
the Contact Center Manager Administration server as HTML files. An example of the prefix for the 
Consolidated Skillset Display is ConsolidatedSkillSet.

Exporting real-time display grids
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The exported file name includes your user name, the prefix that you select, the date 
and time you save the file. For example, if your user name is John, your prefix is 
ConsolidatedSkillSet, and you chose to export the Consolidated Skillset Display as an 
HTML file on April 10, 2000 at 2:45:28 p.m., the system saves it on the server as 
John_ConsolidatedSkillSet_20000410_144528.htm.

Procedure
1. In the left pane, under the server containing the display to customize, click the Private 

Tabular Displays folder.

2. Click the display name.

3. On the Properties page, in the Grid export prefix box, type the prefix to appear in the 
HTML file name.

Note:

Do not include spaces in the prefix.

4. Click Submit to save your changes.

Changing the path to export a summary chart
Before you begin

• Log on to real-time reporting.

About this task
You can choose the folder in which to save summary charts that you export as .bmp or .jpg files. 
The folder that you choose can be on the application server or on your computer.
If you leave this field blank, the system saves the files on your desktop.

Procedure
1. In the left pane, under the server containing the display to customize, click the Private 

Tabular Displays folder.

2. Click the display name.

3. On the Properties page, in the Summary chart export path box, type the folder where 
you want to save snapshots of the network or site summary charts (as .bmp or .jpg files).

For example, to save the summary chart in the My Documents folder on the C drive of your 
computer, type C:\My Documents in this box.

4. Click Submit to save your changes.
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Printing a real-time display grid
Before you begin

• Log on to real-time reporting.

About this task
If you require a hard copy of a real-time display, print a real-time display grid.

Procedure
1. In the left pane, navigate to the display.

2. Double-click the display.

3. In the real-time display grid, click Print.
4. In the Print dialog box, select a printer, or accept the default printer.

5. Click OK.

Printing a real-time display grid
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Chapter 7: Graphical displays

In the Graphical Display window, you can configure one of seven types of graphical displays:

• Billboard displays

• Chart displays

• Time Line displays

• Agent maps

• Collections

• Billboard collections

• Dashboard displays

Prerequisites to graphical display management
Ensure that you have access to the Real-Time Reporting (RTR) component and associated 
access class elements.

Adding a graphical display
Before you begin

• Log on to real-time reporting.

About this task
Create a graphical display.

Procedure
1. From the Displays menu, select Add Graphical Display.

2. In the Name box, type the name of the new graphical display.

The system displays this name on the system tree.

3. From the Server list, select the server on which to create the graphical display.
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4. In the Element Type area, select the type of element corresponding to the type of graphical 
display that you want to create, from the following list:

• Agent: Create an agent map.

• Application: Create an application billboard, chart, or time line.

• IVR: Create an IVR billboard, chart, or time line.

• Skillset: Create a skillset billboard, chart, or time line.

• Agent Position Count: Create an agent position count billboard or chart.

• All: Create a dashboard, a private or public collection, a private billboard or public 
billboard collection.

Note:

The system does not display Agent in the list of element types if you are logged on 
to Contact Center Manager Administration using the webadmin account. The system 
does not display Agent and IVR in the list of element types if you are creating the 
graphical display on a Network Control Center server. The system displays Agent 
Position Count in the list of element types only if you are creating the graphical 
display on a Network Control Center server.

5. In the Presentation area, select the type of graphical display to create.

The type of chart you can create varies according to the selection you made in the Element 
type area.

6. Click Edit Properties to configure the graphical display.

The system displays the corresponding properties window.

Opening a graphical display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create at least one graphical display.

About this task
View a graphical display.

Procedure
1. In the left pane, click the folder containing the graphical display to view.

2. Click the graphical display to view.

3. In the right pane, review the current settings for the graphical display.

4. If you change the settings, click Submit to save your changes.

Opening a graphical display
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5. Click Launch.

While you view an agent map or billboard graphical display, the display can change color. 
This change alerts you when the statistic values exceed the configured threshold values. 
For agent map displays, text flashes when a threshold value is reached, while you view the 
display in the box view (if you configure the display with this feature).

If you select Pop to front, the display appears in front of all open windows. On each 
refresh, the display continues to pop to the front of all open windows, until the data on the 
display falls below the threshold level.

Deleting a graphical display
Before you begin

• If you logged on as the administrative user, or the webadmin, you can open the Public 
Graphical Displays folder and delete the displays.

• If you log on as a user, other than the administrative user, or the webadmin, you can delete 
only the graphical displays that you save in your Private Graphical Displays folder.

• Log on to real-time reporting.

About this task
When you no longer require a graphical display, you can delete the display.

Procedure
1. In the left pane, click the Private Graphical Displays folder.

Note:

When you delete a graphical display, you cannot restore it. Instead, you must create a 
new graphical display.

2. In the list of displays, click the graphical display to delete.

3. In the right pane, click Remove Display.

4. In the message box that appears asking you to confirm your choice, click OK.

Creating a Real-time Dashboard display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can create a Real-time Dashboard display to provide you with multiple views of up-to-date 
statistics for your contact center and its resources.
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Procedure
1. From the Displays menu, select Add Graphical Display.

2. From Element Type, select All.
3. From Presentation, select Dashboard.

4. In the Name box, type the new display name.

Note:

You can use only alphanumeric characters in the display name; do not use special 
characters. The display name must be unique; if you type the same name as an 
existing display, then you overwrite the existing display.

5. Click Edit Properties to configure the display.

6. Click Submit to save your changes.

The new display appears under Private Graphical Displays.

Adding charts to the Real-time Dashboard
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.

About this task
You can add charts to the Real-time Dashboard to view them.

Procedure
1. In the left pane, click the Private Graphical Displays folder.

2. Click the Real-time Dashboard display.

3. Click Launch.

4. From the Displays menu, select a display chart.

5. From the display chart menu, select the data to display on the chart.

The data appears on the chart in the Real-time Dashboard display.
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Changing chart properties in the Real-time Dashboard 
display

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.

About this task
You can change the items that appear on the charts in the Real-time Dashboard to meet your 
requirements.

Procedure
1. Click the Properties tab of the chart to change.

2. Select the skillsets, applications, and statistics to display on the chart.

3. Click the Display tab to display the updated chart.

Note:

If you choose None from the Color Palette drop-down list, in the Display > Options 
menu, the chart is displayed in its default color.

Removing display charts from the Real-time Dashboard 
display

Before you begin
• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.

About this task
You can remove display charts from the Real-time Dashboard display.

Procedure
1. In the left pane, click the Private Graphical Displays folder.

2. Select the Real-time Dashboard display.

3. Click Launch.

4. Click the X button beside the display to remove the display.
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Saving the Real-Time Dashboard display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a Real-time Dashboard display.
• Add a display chart to the Real-time Dashboard.

About this task
Save the Real-time Dashboard display window size and the following attributes of each Real-time 
Display chart:

• size and position of the window
• display type
• list of selected statistics
• list of selected skillsets or applications

Procedure
Close the Real-time Dashboard display window and select Yes on the Save dialog.

OR

Select Save from the File menu.

Making a public copy of a graphical display
Before you begin

• Log on to real-time reporting.

About this task
Make a public copy of a billboard, or chart, or time line graphical display. After you customize 
a display, you can save it in your Private Graphical Displays folder. You can share the saved 
display with other users by making a public copy of it.

Note:
You can make public copies of all types of graphical displays, except agent maps and Real-
time Dashboard displays. Public graphical displays do not support filters. Contact Center does 
not save filters on public copies of your private graphical displays.

You can copy only the display to the Public Graphical Displays folder on the currently selected 
server. You cannot copy graphical displays across all servers on the network to which you have 
access (unlike real-time tabular displays).
After you make a public copy of a private display, only the administrator (logged on as webadmin) 
can delete the display. To modify the display, you or another user must first make a private copy. 
For details about creating public collections and billboard collection displays, see Creating a public 
collection or public billboard collection on page 63.
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Procedure
1. In the left pane, under the server containing the display to copy, click the Private 

Graphical Displays folder.

2. In the list of displays, select the chart or billboard or time line display to copy.

3. At the bottom of the right pane, type the name of the display to appear in the Public 
Graphical Displays folder.

You can only use alphanumeric characters in the display name; do not use special 
characters. If you type the same name as an existing copied display, you overwrite this 
display.

When you copy a private display, the system gives the new display a default name in the 
format [server name]_[private display name]. Since each public display must 
have a unique name, you must type a new name, if you save a public display with the 
same default name. If you do not type a new name, the system overwrites the existing 
display.

4. Click Make Public Copy to save the private display in the Public Graphical Displays 
folder under the same server.

Assigning threshold alerts to a nodal real-time display
Before you begin

• Log on to real-time reporting.
• Create at least one private display. You can customize only the columns in private displays. 

If you choose a public display, you must first copy and save it in your Private displays folder 
before you can customize the columns. See Making a public copy of a graphical display on 
page 49.

About this task
An administrator can use two threshold values, the low value (level 1) and the high value (level 2), 
to define system activity. These values result in three operational levels:

• Below level 1: Based on the type of statistic, this level can mean normal contact center 
operation and no action required (that is, the lower the number of calls waiting, the better), 
or it can signify an alert situation that requires attention (that is, the lower the service level 
percentage, the worse the situation).

• Between level 1 and level 2: This level can indicate a required action to prevent contact 
center performance to move beyond acceptable operating levels.

• Above level 2: Based on the type of statistic, this level can mean normal contact center 
operation and no action required (that is, the higher the service level percentage, the better), 
or it can signify an alert situation that requires attention (that is, the greater the number of 
calls waiting, the worse the situation).
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Procedure
1. In the left pane, under the server that contains the private display to customize, navigate to 

the private display.

2. In the right pane, click the Columns tab.

3. From the sample table, select the statistic for which to define the threshold colors.

4. From the threshold colors boxes, select the colors for the statistic if it is below the level 1 
threshold value, if it reaches a value between level 1 and level 2, and if it exceeds level 2.

5. Click Submit to save your changes.

Configuring an agent map
Before you begin

• You must create the agent filter before you can assign it to the map display and save the 
display. See Creating a filter in real-time reporting on page 22 and Adding agent elements to 
a filter on page 24.

• Log on to CCMA as a standard user. Administrators cannot create agent maps.

About this task
You can configure an agent map to view a representation of all the agents to whom you have 
access in your contact center.

Note:
Supervisors cannot log out an agent, or change an agent’s status, from an agent map; these 
actions are possible only from tabular displays.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new agent map. This is the name that appears in 
the system tree. You can only use alphanumeric characters in the agent map name; you 
cannot use special characters.

3. From the Server list, select the server on which to configure the agent map. You cannot 
create agent map displays on the Network Control Center (NCC) server.

4. In the Element Type area, select Agent.
5. In the Presentation area, confirm that Agent Map is selected.

6. Click Edit Properties to configure the new agent map.

The Agent Map Properties dialog box appears.
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7. In the Agent map title box, type the agent map name to appear at the top of the agent 
map display, or accept the default name. Do not include spaces, special characters, 
punctuation, or the ampersand (&) in the agent map title.

8. Under Display arranged by, select either Agent ID or Position ID.

Note:

In SIP-enabled contact centers, the Position ID option is not available.

9. From the Data collection mode list, select Moving window or Interval-to-date.

10. From the Optional field list, select Position ID or Personal DN to see either in the agent 
map.

11. From the Agent Name list, select how you want the agent name and login ID to appear in 
the header of each icon in the Icon view. You can choose from the following options:

• agent first name, followed by last name

• agent last name, followed by first name

• agent first name and login ID

• agent last name and login ID

12. From the Linked Display list, select the display.

You can choose from all the private, public, and standard displays (both tabular and 
graphical) to which you have access on the currently selected server. If you choose 
nothing from the Linked Display list when you configure the agent map, the Standard 
Agent Display appears for the same server on which you configure the agent map when 
you click Linked Display.

13. From the Associated filter list, select the agent filter to assign to the agent map.

Only filters containing agents on the selected server appear. If your filters contain no 
agents on the selected server, no filters appear in this list.

14. In the Threshold settings area, click the colors to which the text in the box view agent 
map change, when a threshold level is exceeded.

In the icon view, the agent icon changes to these colors when a threshold level is 
exceeded.

When you choose the threshold colors, select colors that make the text easy to view 
against the agent state background colors in box view.

If you do not use a mouse, press Tab until the status bar indicates that you have reached 
the desired color. After reaching the desired color, press the Spacebar to select the color.

15. Select the Pop to front on threshold check box to move the agent map to the front of 
your desktop when a threshold level is exceeded.

The agent map appears in front of all open windows. On each refresh, the agent map 
continues to pop to the front of all open windows, until the data on the display falls below 
the threshold level.
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16. Select the Text Flash on threshold check box to view the text in the launched box view.

The agent map flashes when a threshold level is exceeded. (This option is not applicable 
to the View Agent Map Displays icon.)

17. Select the Hide logged out Agents check box to view logged on agents only when you 
activate the agent map.

If you do not select this check box, you see all agents in the filter that you attach to the 
display, both logged on and logged off.

18. In the Agent State Colors area, select the appropriate check boxes to choose the colors 
to shown for each agent state.

19. Click Submit to save your changes.

The new agent map appears in the system tree under Graphical Displays.

Adding agents to an agent map
Before you begin

• Ensure you have agent elements in a filter. See Adding agent elements to a filter on page 24.

About this task
You cannot add an agent directly to an agent map. Instead, you must add the agent to the filter 
that you assign to the agent map.

Procedure
1. On the main menu, click Filters > Manage Filters.

2. On the Filters tree, click the filter that is assigned to the agent map.

3. Click the Agent tab.

4. Select the agents to add to the agent map.

5. Click Submit to save the changes.

6. On the main menu, click Displays > View Displays.

7. On the system tree, click the Graphical Displays folder under the server containing the 
agent map.

8. Double-click the agent map, and then view the added agent.
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Arranging agents in an agent map using drag and drop
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Launch an agent map display.

About this task
Position an agent within the agent map.

Procedure
1. On the agent map display, click the agent block to move within the display.

2. While pressing the left mouse button on the agent, drag the agent to the new position 
within the agent map.

3. Release the mouse button to leave the agent in the new position.

4. Click Save Layout to save the new arrangement.

Arranging agents in an agent map automatically
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Launch an agent map display.

About this task
Arrange agents in alphabetical order within the agent map.

Procedure
1. On the agent map display, click Tile Agents.

2. Click Save Layout to save the new arrangement.

Customizing the agent map layout
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Launch an agent map display.

About this task
Adapt an agent map layout to meet your requirements.
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Procedure
1. In the agent map, click and drag the agent icons to the desired position.

2. To change the size of the window, place your cursor on the edge of the window until a 
two-headed arrow appears.

3. Click the edge of the window, and then drag it to the desired size.

4. Click Save Layout to save your changes. The next time you open the agent map, your 
custom layout appears.

5. To rearrange the icons automatically in the window, click Tile Agents.

Resizing an agent map
Before you begin

• You must have an agent map. See Configuring an agent map on page 51.

About this task
When you resize an agent map, you can save the size. Your settings remain in effect until you 
resize the agent map again.

Procedure
1. Place your cursor on the edge of the agent map display until it becomes a double-headed 

arrow.

2. Right-click and drag the edge of the agent map to the required size.

3. Release the mouse button.

4. Click Save Layout.

Changing the header format of icons in an agent map
Before you begin

• Log on to real-time reporting.

About this task
You can specify how the agent name and login ID appear in the icon headers when you look at an 
agent map in the icon view.
You can choose from the following options:

• agent first name, followed by last name
• agent last name, followed by first name
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• agent first name and login ID
• agent last name and login ID

Procedure
1. In the Real-Time Reporting main window, click the server containing the agent map to edit.

2. The server expands to reveal a series of folders. On the system tree, click the Public 
Graphical Displays or Private Graphical Displays folder containing the agent map that 
you want to configure.

3. The folder expands to reveal the graphical displays that you save under this server.

4. Click the agent map to configure.

The Agent Map Properties window appears in the right pane.

5. From the Agent Name list, select how you want the agent name and login ID to appear in 
the header of each icon in the Icon view.

6. Review all other properties for the agent map.

7. After you approve the agent map properties, click Submit to save your changes.

The next time you view this agent map in the Icon view, the header for each icon appears 
in the format that you selected.

Zooming in or out on an agent map display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Launch an agent map display.

About this task
While you look at the agent map in the box view, you can resize the display to 50, 75, 125, 150, 
200, or 300 percent of normal size when you use the zoom feature. The resizing option does not 
apply to agent maps that appear in the icon view. When you resize an agent map, the text within 
the agent blocks are also resized, and the relative position of the icons are maintained. To return 
the display to the normal size, select 100 percent from the list.
If you resize an agent map to 50 percent of the normal size, the spacing between the agent map 
icons is halved.

Procedure
From the Zoom list, select a value to resize the agent map.

Graphical displays

September 2025 Using Avaya Aura® Contact Center Reports and Displays 56
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingAvayaAura%C2%AE%E2%80%8EContactCenterReportsandDisplays&p3=27


Activate a display from an agent map
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Configure an agent map.

About this task
On the agent map graphical display, you can view a grid display. When you customize the agent 
map, you can choose which display to view when you click the Linked Display button. You can 
choose from all the private, public, and standard displays (both tabular and graphical) to which you 
have access.
If you do not configure which display to view with the Linked Display feature, the Standard Agent 
Display becomes the default display when you click the Linked Display button.

Procedure
On the agent map display, click Linked Display.

The display that you chose from the Linked Display list activates.

Activate an agent details window from an agent map
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Configure an agent map.

About this task
When you look at an agent map in box view, you can double-click the agent icons to view a 
separate window that lists details about the agent. The window displays the name, login ID, 
supervisor, position ID, and personal DN of the agent. You can double-click the agent icons in the 
display, for both logged on and logged off agents, to activate this details window.

Procedure
1. Launch the required agent map display.

2. Double-click an agent icon in the agent map display.

A new window appears that lists the agent details.
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Configuring a billboard display
Before you begin

• Log on to real-time reporting.

About this task
You can configure a billboard display to select a statistic to monitor closely.
Some agent statistics give misleading totals on a Skillset billboard display, because typically 
agents have more than one skillset assignment. These statistics are:

• Agent Staffed
• Agent Active
• Agent Not Ready
• Agent Idle
• Agent on DN Call
• Agent on Network Skillset Call
• Agent on Other Skillset Call
• Agent Unavailable
• Agent on ACD-DN Call
• Agent on NACD-DN Call

If you select one of these statistics for a Skillset billboard display, and choose the Summary 
option, when you launch the display Contact Center displays a message that the statistic is not 
available.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new billboard graphical display. This is the name 
that appears in the system tree. You can use alphanumeric characters only.

3. From the Server list, select the server on which to create and save the billboard.

4. If you select the NCC server, in the Element Type area, select Agent Position Count > 
Application, or Skillset.

5. If you select a nodal server, in the Element Type area, select Application > IVR, or 
Skillset.

6. In the Presentation area, select Billboard.

7. Click Edit Properties to configure the new billboard display.

8. In the Billboard title box, accept the default name provided, or delete the default name 
and type a custom name to appear at the top of the billboard display.

Do not include spaces, special characters, punctuation, or the ampersand (&) in the 
billboard title.
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9. From the Data collection mode list, select either Moving window or Interval-to-date.

10. For nodal billboards, from the Application or Skillset list, select the application or skillset 
to monitor, or select Summary.

11. For IVR or NCC billboards, you can select only Summary. When you select Summary, 
you can monitor the statistic across all the applications or skillsets in your partition on the 
selected server and across all the applications or skillsets in your partition on all servers on 
the network across all IVR queues on the selected server.

12. From the Statistic list, select the statistic to monitor in the billboard. The name of the 
statistic that you monitor appears in the title bar of the billboard display window when you 
activate it.

13. From the Font color boxes, select the color for the statistic.

The background color of the billboard display is black until a threshold value is reached, 
at which time it changes to either of the threshold colors you selected, and the font color 
changes to black.

If you do not use a mouse, press Tab until the status bar indicates that you have the 
selected color. After reaching the desired color, press the Spacebar to select the color.

14. From the Threshold settings boxes, click to select the colors for the thresholds below 
level 1, between level 1 and level 2, and above level 2, or accept the default colors shown.

You can view the current Level 1 and Level 2 threshold values configured for this statistic 
in the Value boxes beside the threshold settings boxes.

15. Select the Pop to front check box to move the activated billboard to the front on your 
desktop when a threshold level is reached.

The billboard display appears in front of all open windows. On each refresh, the billboard 
display continues to pop to the front of all open windows, until the data on the display falls 
below the threshold level.

16. Click Submit to save your changes.

The new billboard appears in the system tree under Private Graphical Displays.

Configuring a chart display
Before you begin

• Log on to real-time reporting.

About this task
You can configure a chart display for skillsets, applications, or statistics to monitor in a customized 
chart.
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Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new chart graphical display.

This is the name that appears in the system tree. You can use alphanumeric characters 
only.

3. From the Server list, select the server on which to create and save the display.

4. If you select the NCC server, in the Element Type area, select Agent Position Count > 
Application, or Skillset.

5. If you select a nodal server, in the Element Type area, select Application > IVR, or 
Skillset.

6. If you select Application on an NCC server, in the Presentation area, select the Chart 
(choose statistics per application).

7. If you select Application on a nodal server, in the Presentation area, select the Chart 
(choose statistics per application) or the Chart (choose applications per statistic).

8. If you select Skillset on an NCC server or Agent Position Count, in the Presentation 
area, select Chart (choose statistics per skillset).

9. If you select Skillset on a nodal server, in the Presentation area, select the Chart 
(choose statistics per skillset) or the Chart (choose skillsets per statistic).

10. If you select IVR, in the Presentation area, select Chart (choose statistics for IVR 
summary).

11. In the Chart title box, accept the default name, or delete the default name and type a 
custom name to appear at the top of the chart display.

12. From the Chart type list, select the type of chart to configure. You can choose from 
Horizontal Bar, Vertical Bar, or Pie.

13. From the Chart fill list, select Color or Pattern (Black & White).
14. If you select Chart (choose applications per statistic), or Chart (choose skillsets per 

statistic) from the Statistics list, select a statistic.

15. From the Application list, select an application to monitor. Choose Summary to view a 
summary of all applications in your partition on the selected server.

16. For Chart (choose statistics per skillset) on a nodal server, from the Skillset list, select 
a skillset to monitor.

17. Choose Summary to view a summary of all skillsets in your partition on the selected 
server.

If you select Summary, the total for statistics such as Agents Staffed, Agents Active, 
Agents Not Ready, or Agents Idle is shown as 0 because one agent is typically assigned to 
more than one skillset, which results in misleading totals.
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18. From the Data Collection Mode list, select the Moving window or Interval-to-date.

19. In the Export path box, type the path in which to save a copy of the chart that you export 
as a BMP or JPG file (for example, C:\My Documents). If you leave this field blank, the 
file is exported to your desktop.

20. If you select Chart (choose statistics per application), Chart (choose statistics for 
IVR summary), or Chart (choose statistics per skillset), in the Statistic area, select the 
check box for each statistic to view in the chart display.

21. If you select Chart (choose applications per statistic), in the Applications area, select 
the check box for each application to view in the chart display.

22. If you select Chart (choose skillsets per statistic), in the Skillsets area, select the check 
box for each application to view in the chart display.

23. To select all check boxes, click Select All. To clear all check boxes, click Clear All.
24. Click Submit to save your changes.

The new chart appears in the system tree under Graphical Displays and the Graphical 
Display window refreshes.

25. To create a public copy of your custom display, in the Type in the name of your public 
display box, type a name for the public display, and then click Make Public Copy.

A copy of your display appears in the Public Graphical Displays folder.

Creating a private collection
Before you begin

• Log on to real-time reporting.

About this task
You can configure and save your favorite combination of data windows.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new collection.

This is the name that appears on the system tree. You can use only alphanumeric 
characters in the collection name; you cannot use special characters.

3. From the Server list, select the server on which to create and save the collection.

4. In the Element Type area, select All.
5. In the Presentation area, select Private Collection.

6. Click Edit Properties to configure the new collection.
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The Private Collection Properties window appears.

7. From each display list, select a display to include in this collection.

The display lists include all of the public displays and private displays saved on the 
selected server. You can choose a maximum of six different displays.

You must configure the graphical displays on the server before you can include them in 
your collection.

8. Click Submit to save your changes.

The new collection appears on the system tree under Private Graphical Displays.

Creating a private billboard collection
Before you begin

• Log on to real-time reporting.

About this task
You can configure and save your favorite combination of billboards.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new collection or billboard collection.

This is the name that appears on the system tree. You can use only alphanumeric 
characters in the collection name; you cannot use special characters.

3. From the Server list, select the server on which to create and save the private billboard 
collection.

4. In the Element Type area, select All.
5. In the Presentation area, select Private Billboard Collection.

6. Click Edit Properties to configure the new collection.

The Private Billboard Collection Properties window appears.

7. In the Available box, highlight each public or private billboard to include in your billboard 
collection, and then click the right arrow (>) to move the billboard to the Selected box.

Private billboards are marked with an asterisk (*). You can choose from all public or 
private billboards to which you have access on the current server, up to a maximum of 25 
billboards.

8. Click Submit to save the private billboard collection.
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The new billboard collection appears on the system tree under your Private Graphical 
Displays folder on the currently selected server.

Creating a public collection or public billboard collection
Before you begin

• Log on to real-time reporting.

About this task
When you save a public display, you share it with all users that have access to public graphical 
displays on the selected server.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new collection or billboard collection.

This is the name that appears on the system tree. You can use only alphanumeric 
characters in the collection name; you cannot use special characters.

3. From the Servers list, select the server on which to create and save the public collection.

4. In the Element Type area, select All.
5. In the Presentation area, select either Public Collection or Public Billboard Collection.

6. Click Edit Properties.

The Public Collection Properties or Public Billboard Collection Properties window appears.

7. If you create a public billboard collection, proceed to step 10 on page 63.

8. From each display list, select a display to include in this collection.

The lists include all the public grid and graphic displays that you save on the selected 
server. You can choose maximum six different displays.

9. Click Submit to save the public collection.

10. In the Available box, highlight each public billboard to include in your billboard collection, 
and then click the right arrow (>) to move the billboard to the Selected box.

You can choose from all public billboards on the current server, up to a maximum of 25 
billboards.

11. Click Submit to save the public billboard collection.

The new collection or billboard collection appears on the system tree under the Public 
Graphical Displays folder on the currently selected server.
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Arranging the billboards in a billboard collection
About this task
When you first activate a public or private billboard collection, the billboards appear in a default 
order. However, you can change this order by dragging and dropping the individual billboards 
within the billboard collection.

Procedure
1. To rearrange the billboards back in the original layout, click Tile Billboards.

2. Click Save Layout.

Configuring a Time Line display
Before you begin

• Log on to real-time reporting.

About this task
You can configure a time line display for skillsets, applications, or IVR statistics to monitor in a 
customized chart.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new time line graphical display.

This is the name that appears in the system tree. You can use alphanumeric characters 
only.

3. From the Servers list, select the server on which to create and save the display.

4. If you select the NCC server, in the Element Type area, select Agent Position Count, 
Application or Skillset.

5. If you select a nodal server, in the Element Type area, select Application, IVR, or 
Skillset.

6. If you select Application on an NCC server, in the Presentation area, select Time Line 
(choose statistics per application).

7. If you select Application on a nodal server, in the Presentation area, select Time Line 
(choose statistics per application) or Time Line (choose applications per statistic).

8. If you select Skillset on an NCC server or Agent Position Count, in the Presentation 
area, select Time Line (choose statistics per skillset).

9. If you select Skillset on a nodal server, in the Presentation area, select Time Line 
(choose statistics per skillset) or Time Line (choose skillsets per statistic).
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10. If you select IVR, in the Presentation area, select Time Line (choose statistics for IVR 
summary).

11. Click the Edit Properties button.

12. In the Chart title box, accept the default name, or delete the default name and type a 
custom name to appear at the top of the time line display.

13. From the Chart fill list, select Color or Pattern (Black & White).
14. If you select Time Line (choose applications per statistic), or Time Line (choose 

skillsets per statistic) from the Statistics list, select a statistic.

15. From the Application list, select an application to monitor.

16. Choose Summary to view a summary of all applications in your partition on the selected 
server.

17. For Time Line (choose statistics per skillset) on a nodal server, from the Skillset list, 
select a skillset to monitor.

18. Choose Summary to view a summary of all skillsets in your partition on the selected 
server.

If you select Summary, the total for statistics such as Agents Staffed, Agents Active, 
Agents Not Ready, or Agents Idle is shown as 0 because one agent is typically assigned to 
more than one skillset, which results in misleading totals.

19. From the Data Collection Mode list, select the Moving window or Interval-to-date.

20. From the Refresh Rate (seconds) list, select from the available refresh rates of 1, 5, 10 or 
30 seconds.

21. From the Display History (minutes) list, select from the available history values of 1, 5, 
10 or 15 minutes.

22. In the Export path box, type the path in which to save a copy of the chart that you export 
as a BMP or JPG file (for example, C:\My Documents). If you leave this field blank, the 
file is exported to your desktop.

23. If you select Time Line (choose statistics per application), Time Line (choose 
statistics for IVR summary), or Time Line (choose statistics per skillset), in the 
Statistic area, select the check box for each statistic to view in the chart display.

24. If you select Time Line (choose applications per statistic), in the Applications area, 
select the check box for each application to view in the time line display.

25. If you select Time Line (choose skillsets per statistic), in the Skillsets area, select the 
check box for each application to view in the time line display.

26. To select all check boxes, click Select All. To clear all check boxes, click Clear All.
27. Click Submit to save your changes.

The new chart appears in the system tree under Graphical Displays and the Graphical 
Display window refreshes.
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28. To create a public copy of your custom display, in the Type in the name of your public 
display box, type a name for the public display, and then click Make Public Copy.

A copy of your display appears in the Public Graphical Displays folder.

Configuring a Dashboard display
Before you begin

• Log on to real-time reporting.

About this task
You can configure a dashboard display which consists of a set of graphical charts to monitor 
skillset or application statistics.

Procedure
1. In the Real-Time Reporting main window, from the menu, select Displays > Add 

Graphical Display.

2. In the Name box, type the name of the new dashboard.

This is the name that appears in the system tree. You can use only alphanumeric 
characters in the collection name, you cannot use special characters.

3. From the Servers list, select the server on which to create and save the collection.

4. In the Element Type area, select All.
5. In the Presentation area, select Dashboard.

6. Click Edit Properties to configure the new collection.

7. The Collection Properties window appears.

8. In the Dashboard title box, accept the default name, or delete the default name and 
type a custom name to appear as the title of the window when the dashboard display is 
launched.

9. The Install button is enabled if the prerequisite software required to run the dashboard is 
not found on your computer. Click the Install button download and install the relevant .Net 
Framework.

10. Click Submit to save your changes.

The new dashboard appears on the system tree under Graphical Displays.
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Chapter 8: Real-time report customization

The procedures in this section describe how to customize your real-time reports. You can customize 
real-time report displays and real-time report summary charts.

Prerequisites to real-time reporting customization
At least one real-time report must exist. See Adding a graphical display on page 44.

Adding a new column to a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
When you customize your private real-time display grids, you can add new columns by choosing 
from a list of available statistics.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

The folder expands to show a list of private displays.

2. Click the display to customize.

3. Click the Columns tab.

4. From the Available Fields list, select the statistic to add to the real-time display.

5. Click Add Field.

The column appears in the sample display table.

6. Click Submit to save your changes.
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Customizing display properties
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.

About this task
You can customize private display properties to meet your requirements.

Procedure
1. In the left pane, click the Private displays folder.

2. Click the real-time display to customize.

3. On the Properties page, select your customized settings.

4. Click Submit to save your changes.

Changing the refresh rate of a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.

About this task
A slight delay occurs between the events in the contact center and the statistics that you see 
in the displays. The length of the delay depends on the refresh rate settings in the Real-time 
Statistics Multicast (RSM) component and on the application server.
The refresh rate that you specify applies to both the private real-time displays and summary 
charts.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Refresh rate box, type the rate at which to refresh data in the real-time display.

You can specify a minimum value of 0.5 seconds or a number from 1 to 99 (seconds).

5. Click Submit to save your changes.
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Changing the font size in a real-time display grid
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Create a private real-time display.

About this task
You can select the font size for the column headings and the column data in your private real-time 
displays.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Column font size boxes, type the size for the column headings and the column 
data. You can choose a font size from 8 to 14.

If you make no selection, the system applies the default font size of 8.

5. Click Submit to save your changes.

Changing the chart type for a site summary
Before you begin

• Log on to real-time reporting.
• Create a private site summary chart.

About this task
You can specify the chart type for the site performance summaries that you view from each 
real-time display window. You can choose a bar chart or a pie chart.

Procedure
1. In the left pane, under the server that contains the display to customize, navigate to the 

site summary chart.

2. In the right pane, on the Properties tab, from the Type for site summary list, select the 
chart type to use to display the performance summaries of each site in the network.

3. Click Submit to save your changes.
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Changing the color settings of a real-time display grid
Before you begin

• Log on to real-time reporting.

About this task
You can configure the color settings for the data, filter and site subtotals, and the summary rows of 
the real-time display grids. If you choose no custom color, the system applies the default colors to 
each area.
The summary rows include the Ntwk (Network) Total in the network-consolidated real-time 
displays, and the [site name] Total in the nodal real-time displays. The subtotal rows contain the 
statistics subtotals for each site in the network (for network-consolidated displays), and for each 
filter group.

Procedure
1. In the left pane, under the server that contains the display to customize, navigate to the 

display.

2. In the right pane, on the Properties tab, in the Color settings area, choose the color 
settings to appear in the real-time display grids.

3. Click Submit to save your changes.

Changing the fill color of a summary chart
Before you begin

• Log on to real-time reporting.

About this task
You can specify whether to view the performance summary charts in black and white or color. If 
you select black and white, the system represents the summary statistics in varying shades of 
gray with distinct patterns for each type of data. If you select color, the system assigns a different 
color to represent each type of data.

Procedure
1. In the left pane, under the server that contains the display to customize, navigate to the 

display.

2. In the right pane, on the Properties tab, from the Site summary fill and Network 
summary fill lists, select whether to see the charts in color or in a black and white pattern.

3. Click Submit to save your changes.

The option that you choose becomes the default color for all site summary and network 
summary charts. However, when you view a chart, you can change the fill color instantly by 
clicking Color/Pattern at the bottom of the chart panel.
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Changing column names
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can change the column names of private displays. You can customize the columns of only 
private displays. If you choose a public display, you must first copy it and save it in your Private 
Displays folder before you can customize the columns.

Procedure
1. In the left pane, navigate to the real-time display to customize.

2. In the right pane, click the Columns tab.

3. To add columns to the display, from the Available Fields list, select a column, and then 
click Add Field.

4. In the Column Name box, type the new name to appear in the real-time display grid, and 
then press Tab.

The new column name appears in the sample table.

You can change as many names as you want.

5. After you change the names, click Submit to save your changes.

6. Click Launch Display to view the real-time display to see your changes.

Changing the column width in a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can customize the columns of only private displays. If you choose a public display, you must 
first copy it and save it in your private folder before you can customize the columns.

Procedure
1. In the left pane, under the server that contains the real-time display to customize, navigate 

to the display.

2. In the right pane, click the Columns tab.

3. Click the name of the column to resize.

4. In the Column width box, type the width of the column in characters.
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Note:

You cannot make the column narrower than the column text. To shrink the column to 
the exact width of the column heading text, type a low number of characters in the 
Column width box (for example, type 5).

5. Click Submit to save your changes.

6. Click Launch Display to start the real-time display and to view your changes.

Rearranging columns in a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can rearrange the columns only of private displays. If you choose a public display, you must 
first copy it and save it in your Private Tabular Displays folder before you can customize the 
columns.
You cannot move the Site, Filter, Skillset, or Application column headings. However, you can 
choose the order in which they appear in the private network-consolidated real-time displays.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the private display to customize.

3. In the right pane, click the Columns tab.

4. Click the name of the column to move.

5. Click Move Left or Move Right to move the column heading to the desired position.

6. Click Submit to save your changes.

Changing the data collection mode of a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Specify the mode in which you want to view collected contact center data.

Procedure
1. In the left pane, click the Private Tabular Displays folder.
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2. Click the display name.

3. In the right pane, click the Properties tab.

4. From the Data collection mode list, select the mode in which to view the collected data.

5. Click Submit to save your changes.

Changing the title of a real-time display grid
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
Select the title to appear at the top of each private real-time display grid.

Procedure
1. In the left pane, click the Private Tabular Displays folder.

2. Click the display name.

3. In the right pane, click the Properties tab.

4. In the Display Title box, type the title to appear at the top of the real-time display.

If you do not type a title, the system applies the default title.

5. Click Submit to save your changes.

Deleting columns from a real-time display
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• You can customize the columns of only private displays. If you choose a public display, 

you must first copy it and save it in your Private Tabular Displays folder before you can 
customize the columns.

About this task
When you customize your private real-time display grids, you can delete any column except for 
the Site, Filter, Skillset, and Application columns.

Note:
If you delete the Answered Skillset column, the Contact Type icons do not display in the 
Contact Status column.
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Procedure
1. In the left pane, navigate to the private display to customize.

2. In the right pane, click the Columns tab.

3. From the sample table, click the statistic to delete from the real-time display.

4. Click Delete.

5. Click Submit to save your changes.

Moving the chart contents within the window
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.

About this task
You can move the summary chart contents within the window frame to concentrate on specific 
areas of the chart.

Procedure
1. While viewing the chart, press Shift.
2. While pressing Shift, hold down both mouse buttons.

3. On the chart, move your mouse to drag the contents to the desired position.

4. Release Shift and the mouse buttons.

5. To restore the chart to the original state, press R on your keyboard.

Rotating a summary chart
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.

About this task
Rotate a summary chart to view the complete content.
You cannot rotate network summary charts.

Procedure
1. While viewing the chart, press Shift.
2. While pressing Shift, hold down both mouse buttons.
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3. Move your mouse in a circular direction.

The chart contents rotate.

Increasing or decreasing the summary chart size
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.

About this task
Customize the size of the chart contents within the chart frame. You cannot increase the size of 
the chart frame.

Procedure
1. While viewing the chart, press Ctrl.
2. While pressing Ctrl, hold down both mouse buttons.

3. On the chart, move your mouse upward to decrease the size of the chart contents or 
downward to increase the size of the chart contents.

4. After you adjust the size appropriately, release Ctrl and the mouse buttons.

5. To restore the chart to the original state, press R on your keyboard.

Zooming in on areas of a summary chart
Before you begin

• Log on to Contact Center Manager Administration Real-Time Reporting.
• Open a summary chart.

About this task
Zoom in on a summary chart to view specific information.

Procedure
1. While viewing the summary chart, press Shift.
2. While pressing Shift, click and drag to select the area of the chart to view more closely.

3. Release Shift and the mouse button.

The area increases in size.

4. To restore the chart to the original state, press R on your keyboard.
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Chapter 9: Contact Center Multimedia 
reports

This section provides procedures to generate Contact Center Multimedia (CCMM) reports.

Prerequisites to CCMM reports
Ensure you have the Historical Reporting-Report Creation access class, so that you can run 
Report Creation Wizard (RCW).

Creating a CCMM report template for user-created reports
About this task
To configure the selection criteria in a report, you must create a CCMM report.

Procedure
1. In Contact Center Manager Administration, click Launchpad > Historical Reporting.

2. In the system tree, click the server to log on to.

3. From the menu, choose Report > Report Creation Wizard.

4. Select the Advanced Report (via OBDC) option.

5. Click Next.
6. In the DSNs Available list, click CCMM DSN.

Note:

The OBDC DSN must be CCMM_<IPaddress>_DSN.

7. In the Selected DSN Properties area, type the user ID and password. If the fields 
automatically fill in with values, proceed to step 8 on page 76.

8. Click Next.
9. From the Tables Available list, double-click a table.
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10. To add another table, repeat step 9 on page 76; otherwise click Next.
11. If you select only one table, skip to step 17 on page 77. If you select multiple tables, 

continue from step 12 on page 77.

12. From each of the left and right Tables lists, select a table.

13. From each of the left and right Fields lists, click a field to include.

Note:

The selected field on the right Fields list must contain the same data as the selected 
field on the left Fields list.

14. From the Join list, select a join type.

15. Click Link.

16. Click Next.
17. In the Fields list, double-click a formula or field to add to the report.

18. Use the up and down arrows to change the order of the selected fields.

19. Click the Configuration icon.

20. In the report layout section, select Portrait or Landscape.

21. On the toolbar, click the Save Report icon.

22. Select the folder in which to save the report.

23. In the Report Name box, type the name of the report.

24. Click Save.

Importing a CCMM user-created report
Before you begin

• Install Report Creation Wizard.

About this task
Import a Contact Center Multimedia report into Report Creation Wizard to customize the report 
layout and to add and delete database tables and database fields.
The following is a list of items and features that you cannot edit, delete, or add to a report:

• Connections
• Formulas
• Record selection formulas
• Subreports
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Procedure
1. On the Report Creation Wizard tool bar, click the Import to Historical Reporting icon.

2. In the Report Title box, type the name of the report.

3. Click Browse.

4. Navigate to the report to import.

5. Click Open.

6. From the Time Zone list, select the time zone of the server to which you want to import the 
report.

7. In the Comment box, type additional information about the report.

8. Click the Report Options header.

9. Select a Report Mode.

10. For advanced reports, from the Report Type list, select the report type.

11. From the Report Group list, select the folder from which the report is imported.

12. In the Select Server list, select the servers to which you want to import the report.

13. Click the Data Range header.

14. From the Table Alias list, select a table.

15. In the Table box, for the data range that matches the selected Table Alias time period, 
type the table name.

16. In the Timestamp box, for the data range that matches the selected Table Alias time 
period, type the name of the field.

17. Click Import.
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Chapter 10: Historical reporting

You can select the server in Contact Center Manager Server from which to run and schedule 
performance, configuration, and network reports (if you work in a networked environment). Reports 
help you monitor system performance by providing information about system activity.

You can also designate the Standby Server to generate historical data for the historical reports to 
reduce the load on the primary servers. For more information about configuring the server from 
which to draw Historical statistics, see Avaya Aura® Contact Center Client Administration.

Note:

Depending on the amount of data in the report, it can take a long time for the report to appear in 
Contact Center Manager Administration. If this time exceeds the execution timeout value within 
Internet Information Services (IIS), the report can fail to load. To ensure the report loads with 
a manageable amount of data, use selection criteria to filter the data or select a shorter data 
range before you run reports.

Note:

Contact Center blocks historical reports that pull more than 50,000 records from the database. 
This maximum limit safeguards the memory and CPU usage on the Contact Center server. 
Avaya recommends that you run reports with selection criteria that reduce the amount of data 
on the report.

Note:

Contact Center limits the number of items shown in the document map of the Report Viewer to 
5000. The document map is the navigation pane that appears on the left side of most reports. 
Once the limit is reached, Contact Center disables the document map and it is no longer visible 
in the Report Viewer. However, if there are multiple levels in the document map of a report, 
Contact Center removes the lowest level first and continues the removal until the number of 
items falls below 5000. For example, the document map for the Agent Performance report 
shows two items: Agent Name & ID, and the Date. If removing the Date from the document map 
reduces the number of items to 5000 or less, the Report Viewer displays the Agent Name & ID 
only. If Contact Center cannot reduce the number of items in the document map to 5000 or less, 
the document map is disabled.

The format of exported historical reporting data varies depending on which version of Avaya Aura®

Contact Center you are using.

Microsoft SQL Server Reporting Services (SSRS) has limitations when exporting reports. If the 
report exceeds SSRS limits, the export can fail. For more information about SSRS limitations when 
exporting to different formats, refer to Microsoft SSRS documentation.
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Prerequisites to Historical Reporting
• Log on to Contact Center Manager Administration.
• Ensure that you have the required access to work in Historical Reporting.
• Ensure that you understand Historical Reporting.

Logging on to Historical reporting
Before you begin

• Ensure that you have access to Historical reporting.

About this task
To access Historical Reporting, log on to the Historical Reporting component in Contact Center 
Manager Administration.

Procedure
1. Log on to Contact Center Manager Administration.

2. On the Launchpad, click Historical Reporting.

The Historical Reporting window appears.

Applying filters to network-consolidated historical reports
Before you begin

• Log on to Historical Reporting.
• At least one filter must exist. See Creating a filter in real-time reporting on page 22.

About this task
When you configure a network-consolidated historical report on the NCC server, you have two 
choices for adding the selection criteria:

• Network Sites: You can select the network sites to include in the report from those listed in 
the Available table. To select individual sites, select the check box beside the site names, and 
then click Update Selection Criteria.

• Filters: Click the Filters heading to choose from the filters that you created and saved. The 
filter names appear in a table. To select the filters to include in the report, select the check 
box beside the filter names, and click Save Report or Run Now.

While you can apply more than one filter to a report, the combined total number of filter elements 
in all filters that you apply to a single report cannot exceed 300. For example, you can apply 
one filter that includes 200 skillsets, and another filter that includes 100 skillsets to a single 
network-consolidated report because the total number of filter elements is 300.

Historical reporting
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Procedure
1. In the right pane, click the NCC server that contains the network-consolidated report to 

define.

2. Click the Public Report Templates folder.

3. Click the NCC folder.

4. In the NCC folder, select the report to use.

5. Click the Selection Criteria heading.

6. Click the Filters heading.

7. In the table, select the check box for each filter to apply to the report.

8. Click Run Now to generate the report.

9. To save your changes, in the Save As box, type a name for the report, choose a save 
location, and then click Save Report.

Defining the selection criteria
Before you begin

• Log on to Historical Reporting.

About this task
Users of the Avaya Aura® Contact Center can create filters. However, each of these filters 
contains only one of the following types of data:

• skillsets
• applications
• route numbers
• route names
• DNIS numbers
• DNIS names

An administrator can use the Contact Center Manager Server filter-importing utility to import filters 
(that were created and saved in the Avaya Aura® Contact Center) into Contact Center Manager 
Administration. While each of the classic client filters contains only one type of data— skillsets, 
applications, route numbers, route names, DNIS numbers, or DNIS names—you can add various 
types of data to these filters, after the administrator imports them by using the filter tabs in 
Historical Reporting. For more information on filters, see Filter management on page 22.
You can select the elements to include in your reports by assigning filter elements to your reports. 
For example, in an agent performance report, you can choose the agents for whom to generate 
the report. You can define the selection criteria for public, private, and shared reports that you 
schedule or run on demand.

Defining the selection criteria
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If you connect to an NCC server and run a network-consolidated report, you can choose from 
the saved configured filters. Use filters to select the sites and resources to include in a network-
consolidated report. For more information, see Creating a filter in real-time reporting on page 22.
By default, if you do not define the selection criteria, the system applies partition rules to generate 
the report. However, if you select a filter element, you see only that element in the report. You 
can select a maximum of 300 elements from the available list to run the report. For example, you 
choose a skillset report and see a list of 20 skillsets in the Available filter elements box. If you 
select no skillsets, you see all 20 skillsets in the report, whereas if you select 3 skillsets, you see 
only 3 skillsets in the report. For two table reports, for example, Skillset By Agent Performance 
report, you can select 300 agents and 300 skillsets to run the Skillset by Agent Performance 
report.
The number of elements defined in a users partition profile is an important consideration when 
running historical reports. If the combined number of a particular element is greater than 300, then 
it is necessary for the user to select a subset of 300 elements or less in order to run that report. 
If no selection criteria is selected, all available elements to that user are applied to the report – 
Contact Center supports only 300 elements or less. Consider the following example:
A user is assigned three user defined partitions, configured as follows:

Partition Name Elements
Sales Agents Contains 200 agents from CCMS1
Support Agents Contains 80 agents from CCMS1
Service Agents Contains 50 agents from CCMS1

If the user runs the standard Agent Performance report against CCMS1, the report fails to run and 
displays this error: “The maximum number of elements supported by the SQL Query is 300. Select 
up to 300 elements to save/run this report or leave the selection criteria blank to report on all 
data.” This error appears because the user did not define any selection criteria and the maximum 
element limit is reached. In a user defined partition, the number of elements must not exceed 300. 
If the number of elements exceeds 300, it has the same effect as defining a selection criteria of 
more than 300 elements. To avoid this, assign less partitions to the user or use standard partitions 
to allow reports to be run for all elements.
The filter elements available depend on the type of statistics included in the report. If you select 
multiple filter elements, only those that satisfy all filter criteria appear in the report. For example, 
if you choose to report on five agents and three activity codes, if one agent uses no activity code, 
the agent does not appear in the report.

Procedure
1. In the left pane, click the server that contains the report to define.

2. Expand the folder that contains the report template to use.

3. Click the folder containing the type of report to change.

4. Select the report to use.

5. In the right pane, click the Selection Criteria heading.

Historical reporting
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6. In the Selection Criteria area, enter information in the following boxes:

• Available heading: Click this heading to view the available filter elements for this report. 
A table appears, listing the available elements. If multiple filters exist for this report, 
more than one Available table appears. Select the check box for each filter element 
to apply to the report, and then click Update Selection Criteria. The selected filter 
elements appear in the Selected table.

• Selected heading: Click this heading to view the filter elements selected for the report. 
A table appears, listing the selected elements. To remove selected filter elements, clear 
the check box for each filter element, and then click Update Selection Criteria. The 
element appears in the Available table.

• Filters heading: This heading is visible only if you connect to the NCC server and work 
with a network-consolidated report. Click this heading to view the available filters for this 
report. A table appears with a list of the available filters. To add a filter to this report, 
select the check box beside the filter name, and then click Update Selection Criteria. 
The selected filters appear in the Selected table.

7. Click Run Now to generate the report.

8. To save your changes, click Report Details, in the Save As box, type a name, choose a 
save location, and then click Save Report.

Opening a public, private, or shared report
Before you begin

• Ensure that you have access to public report groups in Access and Partition Management.
• Log on to Historical Reporting.

About this task
Open a public, private, or shared report to view a historical report.

Procedure
1. In the left pane, select the server on which to view the list of reports.

2. Select one of the following folders:

• Public Report Templates: This folder contains the standard report templates in Contact 
Center Manager Server. Run public reports on demand basis, or you save them in 
your Group or Private Report Templates folders and schedule them. The Public Report 
Templates folder can contain template folders corresponding to the following types of 
reports:

- Agent Performance reports

- Call-by-Call reports

- Configuration reports

Opening a public, private, or shared report
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- Contact Summary reports

- Multimedia reports

- Networking reports

- Other reports

- Outbound reports

The template folder displays depend on the version and features available on the server. 
In addition to these folders, the Network Control Center (NCC) server includes one 
public report templates folder, the NCC folder.

• Private Report Templates: This folder contains the report templates that you create 
by modifying an existing public, shared, or private report template, and saving your 
changes in your Private Report Templates folder. You can modify report information, 
schedule the report, and apply filters. For more information about creating private 
reports, see Creating a shared or private report on page 86.

• Group: This folder contains shared report templates. When you customize a public or 
private report template and save it in your Group folder, all other users who have access 
to your group can run and schedule the group report templates.

Note:

In the Group folder, you can modify a report template only if you are the owner of 
the report template.

3. From the expanded list, select a report template to modify or schedule the template, or run 
the report on demand.

The report properties appear in the right pane.

Running an Ad hoc report
Before you begin

• Ensure that you have access to the report folder that contains the report to run.
• Log on to Historical Reporting.

About this task
You can specify the amount of data to include in an Ad hoc report by choosing the data range and 
applying selection criteria. After you customize your report, click Run Now to generate the report 
immediately. In the resulting Ad-hoc Report Viewer window, you can choose to print or save the 
report.
You can select the data range for agent performance, call-by-call, and some networking reports 
before you generate them. You cannot select the data range for configuration reports.

Historical reporting
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Procedure
1. In the left pane, select the server that contains the report to run.

2. In the expanded list, select the folder that contains the report template to run.

3. Click the folder containing the report to run.

4. Select the report template to run.

5. To view the current report properties, in the right pane, click the following headings:

• Report Details
• Selection Criteria
• Data Range
• Schedule
• Output Options: This section appears only if you previously scheduled the report.

6. To run the report with the current properties, proceed to step 9 on page 85.

Note:

If you do not define the selection criteria, the system enforces partition rules to 
generate the report.

7. To define the selection criteria and the data range, see Defining the selection criteria on 
page 81.

8. To save your properties, in the Save As box, type a report name, choose a save location, 
and then click Save Report.

9. Click Run Now to generate the report.

Exporting an Ad hoc report
Before you begin

• Log on to Historical Reporting.

About this task
Export a report to convert the visual display to a required format.

Procedure
1. In the left pane, click the server that has the report to print.

2. Double-click the folder with the report to print.

3. From the expanded folder, select the report.

4. In the right pane, click Run Now to generate the report with the specified properties.

The Ad-Hoc Report Viewer appears and displays the generated report.

Exporting an Ad hoc report
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5. Click the Export drop-down menu and select an export type. Choose from Excel, PDF, or 
Word.

6. After you select the export type, you can choose to open or save the report in the chosen 
exported format.

Creating a shared or private report
Before you begin

• Ensure that you have access to the folder that contains the report to use.
• If you schedule the report, activate the schedule. See Activating a scheduled report on 

page 96.
• Log on to Historical Reporting.

About this task
You can create custom reports if you change existing public, shared, or private report templates to 
suit your needs. Save them in your Group or Private Report Templates folders. When you save a 
report in your Group folder, you save a shared report; that is, you share the report with other users 
who have access to your Group folder.
If you do not want to use an existing report as the basis for your custom report, you must create 
a new report using Microsoft Report Designer and import it into the Contact Center Manager 
Administration Historical Reporting application. See Importing a report on page 89.

Procedure
1. In the left pane, select the server on which to create the report.

2. Navigate to the folder that contains the report template to use.

3. Click the report to change.

4. In the right pane, click the following headings:

• Selection criteria.

• Data range (not applicable for configuration reports)

• Schedule
5. Click Report Details.

6. In the Report Title box, type the name to appear at the top of the generated report. If 
you do not type a new report title, the default title in this box appears at the top of the 
generated report.

Note:

If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports when you 
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generate them. If you do not change the report title, all copies of the same public report 
have the same standard title when you generate the reports.

7. In the Save As box, type the new report name.

Note:

If you choose a Public report template as the basis for your custom report, and you 
want to save the new properties that you enter, you must type a new name in the 
Save As box and specify whether to save it in your Private or Group folder. If you use 
an existing private or shared template as the basis for your custom report, you can 
choose to make a copy of the report by changing the report name in the Save As 
box, or you can leave the report name and overwrite the existing template with your 
changes.

8. From the Location list, select the save location for your custom report. You can choose 
between your Private and Group folders (if you have access to a group folder).

9. In the Comment box, type comments about the report.

10. From the Time Zone list, select the time zone in which you want to define the data range 
for this report, or accept the default time shown (the system defaults to the Contact Center 
Manager Server time zone). The data range depends on Contact Center Manager Server 
time since the server stores the data. Therefore, the system always converts the data 
range times that you enter to Contact Center Manager Server time.

11. Click Save Report to save your changes.

The report appears in the Group or Private Report Templates folder on the server that you 
select.

Defining the report output
Before you begin

• Log on to Historical Reporting.

About this task
You can specify whether to print the scheduled report when it generates, save it as a file, or both. 
You can also specify one or more email addresses where the system can send a notification after 
the report generates.
If you save the report to a file, you must specify a shared folder to which the Contact Center 
Manager Administration server sends the output file. This folder can be on your computer, on 
another computer in the network, or on the application server. To send the file to a folder on 
a computer in the network, the network computer must be accessible from the Contact Center 
Manager Administration server.

Defining the report output
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Procedure
1. In the left pane, click the server containing the report whose output options you want to 

define.

The server expands to reveal a choice between Public, Private, and Group folders (if you 
have access to a group folder).

2. Expand the folder containing the report template to use.

3. Navigate to the report to edit.

The report properties appear in the right pane.

4. Click the Report Details heading.

5. In the Report Title box, type the name to appear at the top of the generated report.

If you do not type a new report title, the default title in this box appears at the top of the 
generated report. Do not include apostrophes (’) in the report title.

Note:

If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports when you 
generate them. If you do not change the report title, all copies of the same public report 
have the same standard title when you generate the reports.

6. In the Save As box, type the new report name.

The name appears in the system tree. This name cannot contain apostrophes (’) and it 
must be unique, if you save the report in the same folder.

7. From the Location list, select the folder in which to save your report. You can choose 
either Private or Group (if you have access to a group folder).

8. From the Time zone list, select the time zone in which to schedule your report, or accept 
the system default (the default time zone is time zone of the selected server).

Note:

When you select the schedule time for your report, the system converts the time that 
you choose to the Contact Center Manager Administration server time, and gives the 
generated report the Contact Center Manager Administration server timestamp (if you 
choose a time zone other than the one in the Contact Center Manager Administration 
server.)

9. Click the Schedule heading.

The heading expands to reveal a series of boxes.

10. In the schedule area, enter the report schedule.

11. Click the Output Options heading.

The heading expands to reveal a series of boxes.
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The Output Options heading is disabled until you schedule the report.

12. In the Output Options area, choose the report output type:

• Print: When you select this option, you can choose the printer, or accept the default 
printer shown. You can also select the paper size for the report from the Paper Size list.

• Output to file: When you select this option, you must type the location where the report 
is saved in the Output box in the format \\[computer name]\[shared folder 
name]\[file name]. You can then choose the report file format or accept the default 
format.

• Email Notification: When you choose this option, you must enter an email address 
in the box provided. The system notifies you by email when the report run is finished 
and report is generated. To enable multiple users to receive notification that a report is 
generated, you can type multiple email addresses in the box, each address is separated 
by a semicolon (;). You can type a maximum of 255 characters in the email address box.

13. Click Save Report to save your changes.

14. To activate the schedule, in the left pane, select the Scheduled Events folder.

15. In the expanded folder, select the report that you just scheduled.

16. Click Activate.

The system activates the schedule and outputs the report to the location that you specify.

Importing a report
Before you begin

• Log on to Historical Reporting.

About this task
You can use the Report Template Importing Wizard to import report templates into Contact Center 
Manager Administration that you create using Microsoft Report Designer. When you import a 
report template, you save it on the Contact Center server. However, you access the report 
template by opening your Private Report Templates folder on the same server to which it is 
imported.
You can also use the Report Template Importing Wizard to import existing, custom Contact Center 
Manager Server report templates, one at a time into Contact Center Manager Administration.
To share the report template with other users, you must save your private report in your Group 
folder (if you have access to a group folder). For more information, see Creating a shared or 
private report on page 86.
You can import two types of reports: Historical or Configuration.

Importing a report
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Note:
For imported reports, characters are limited to the English language and characters supported 
by the server code page only. A code page is an internal table that the operating system 
uses to map symbols (letters, numerals, and punctuation characters) to a number. For more 
information about server code pages and language support for Contact Center Manager 
Administration, see Avaya Aura® Contact Center Server Administration.

Procedure
1. In the left pane, click the server to which to import the new report template.

2. From the Report menu, select Import.
3. In the Template Importing Wizard, follow the prompts to import your report template to 

the server.

Editing a report
Before you begin

• Log on to Historical Reporting.
• Ensure that you are familiar with defining selection criteria. See Defining the selection 

criteria on page 81.
• Ensure that you are familiar with scheduling reports. See Scheduling a report on page 92.
• For network-consolidated reports, you can choose the network sites or filters that you created 

and saved. See Selecting the network sites for a network-consolidated report on page 97
and Applying filters to network-consolidated historical reports on page 80.

• If you edit a scheduled report, you must deactivate the schedule before you can save your 
changes. See Deactivating a scheduled report on page 96.

About this task
You can edit the properties of private reports or shared reports that you create and save in 
your Group folder. You can change properties such as the data range, the selection criteria, the 
schedule, and the report title. You must click Save Report to save the new properties.
You can change the properties of a public report template only if you save a copy of the template 
as a shared or private report. See Creating a shared or private report on page 86.

Procedure
1. In the left pane, click the server containing the report to edit.

2. Navigate to the report to edit.

The system loads the report properties, and a series of headings appears in the right pane.

3. Click the Report Details heading.

The heading expands to reveal a series of boxes.
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4. In this section, you can change information in the following boxes:

• Report Title: The title that appears at the top of the generated report. Do not include 
apostrophes (’) in the report title.

• Comment: Type comments about the report.

• Save As: The name of the report. All reports saved in the same folder must have unique 
names. This name cannot include apostrophes (’). You must enter a name in this box 
when you save the report in a different folder. If you save the report in the same folder 
and do not change this name, the system overwrites the existing report with your new 
properties.

• Save Location: Select the folder in which to save the custom report. If you select 
Group, all members of your group have access to the report. If you select Private, only 
you have access to the report.

• Time Zone: Select the time zone in which to schedule or define the data range for 
this report, or accept the default time shown (the system defaults to the Contact Center 
Manager Server time zone). The data range depends on Contact Center Manager 
Server time since the server stores the data. Therefore, the system always converts the 
data range times that you enter to the Contact Center Manager Server time.

5. Click the Selection Criteria heading.

The heading expands to reveal a series of boxes.

6. Specify the information to include in your report by assigning filter elements (or filters if you 
work with a network-consolidated report).

7. Click the Data Range heading.

The heading expands to reveal a series of boxes.

8. Change the time range, during which the data collects, to specify the amount of data to 
include in your report.

If the data range is None and disabled, the report does not require a data range.

9. Click the Schedule heading.

10. Indicate when and how often to generate your report.

11. Click the Output Options heading (only if you schedule the report). The heading expands 
to reveal a series of boxes.

12. Specify whether to save or print the report.

You can enter email addresses on which the system sends a notification to indicate if the 
report generates successfully.

13. Click Save Report.

Note:

If you click Run Now to generate an on-demand report, property changes are not 
saved.
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Printing an Ad hoc report
Before you begin

• Log on to Historical Reporting.

About this task
You can print an on-demand report from the Ad-Hoc Report viewer.
Before you can print the report, you must run it. You can run the report with the current properties, 
or you can define the selection criteria and the data range, and then run the report. See Defining 
the selection criteria on page 81.
By default, if you do not define the selection criteria, all available data is included in the report 
when you run it. When you define the selection criteria, you can choose the data that you want to 
see.
For information about printing scheduled reports, see Defining the report output on page 87.

Procedure
1. In the left pane, click the server containing the report to print.

2. Double-click the folder containing the report to print.

3. From the expanded folder, select the report.

4. In the right pane, click Run Now to generate the report with the properties specified.

The system displays the Ad-Hoc Report Viewer and the generated report.

5. Click the printer icon to print the report to the default printer configured on your computer.

Scheduling a report
Before you begin

• Log on to Historical Reporting.
• Ensure that you are familiar with defining selection criteria. See Defining the selection 

criteria on page 81.

About this task
You can schedule reports in your group and private folders to send a report to a file or to print 
a report, or both. You can also specify one or more email addresses where you can receive 
notification that the report generated, or if problems occurred that prevented it from generating 
successfully.
You can change the properties of a public report template only by saving a copy of the template as 
a shared or private report. See Creating a shared or private report on page 86.
If you choose to send the report to a file, you must specify a shared folder where the Contact 
Center Manager Administration server sends the file. This folder can be on your computer, on 
another computer in the network, or on the application server. To send the file to a folder on 
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a computer on the network, the network computer must be accessible from the Contact Center 
Manager Administration.
Avaya recommends that you select a start time that does not exactly match an interval start time. 
If the scheduled report start time matches the start of an interval, it is possible that the report does 
not contain data for the previous interval. This happens when Contact Center does not complete 
writing interval data to the database before the scheduled report starts. This can occur because 
of , for example, the database size, or the volume of contacts processed in the interval. Avaya 
recommends that you avoid starting reports on the hour, or on fifteen, thirty, or forty-five minutes 
after the hour. Instead, schedule reports five minutes after intervals, for example 07:05 or 16:20.

Note:
The report schedule that you define cannot start in the p.m. range and end in the a.m. range. 
After the system converts your selected time to Contact Center Manager Administration server 
time, if the converted start time is in the p.m. range and the converted end time is in the a.m. 
range, an error message appears. In this case, you must re-enter the schedule start and end 
times, taking into account the time difference with the application server.

Procedure
1. In the left pane, click the server containing the report to schedule.

2. Expand the folder containing the report template to use.

3. Click the folder containing the report type to schedule.

4. In the expanded folder, select the report to schedule.

5. In the right pane, click the Report Details heading.

6. In the Report Title box, type the name to appear at the top of the generated report.

Note:

If you do not type a new report title, the default title in this box appears at the top of the 
generated report. Do not include apostrophes (’) in the report title.

7. If you save multiple copies of the same public report in your Group or Private report 
templates folders, change the report title to distinguish between reports.

Note:

If you do not change the report title, all copies of the same public report have the same 
standard title when you generate the reports.

8. In the Save As box, type the new report name.

The name appears in the system tree. This name cannot contain apostrophes (’) and it 
must be unique, if you save the report in the same folder.

9. From the Location list, select the folder in which to save the report.

You can choose either Private or Group (if you have access to a group folder).

10. From the Time zone list, select the time zone in which to schedule your report, or accept 
the system default (the time zone defaults to the time zone of the selected server).
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11. Click the Selection Criteria heading.

12. In the Selection Criteria area, click the Available and Selected headings to choose the 
selection criteria for the report.

13. Click the Schedule heading.

14. In the Schedule area, select the report schedule criteria.

Note:

If you select dates for the report to generate, the report generates for the selected 
dates each year for as long as the report is scheduled. For this reason, you cannot 
select to generate the report on February 29 in a leap year, as the following year is not 
a leap year.

15. Click the Output Options heading.

16. In the Output Options area, choose the report output:

• Report output: Choose whether to print the report, send it to a file, or both.

• Printer: Select the printer.

• Paper Size: Choose the paper size.

• Output: Type the path to the shared network folder in which to save the report.

• Format: Select the report format.

• Save the file under a different name each time: Save each report with a unique 
name. If you do not choose this option, the system overwrites the existing report.

• Email Notification: Select this option to receive an email notification after the report 
generates, or if the report does not generate successfully. Enter an email address in 
the box provided. The system notifies you by email when the report run is finished and 
the report is generated. To enable multiple users to receive notification that a report 
generated, you can type multiple email addresses in the box, each address is separated 
by a semicolon (;). You can type a maximum of 255 characters in the email address box.

Note:

Contact Center Manager Administration Historical Reporting scheduled reports do not 
support the "Print to file" type of printer.

17. Click Save Report to save your schedule.

18. Click Activate to activate the schedule.

19. To verify that the report schedule is active, select the Scheduled Events folder, and then 
locate the scheduled and activated report to view the status and properties.
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Variable definitions
Variable Definition
start time The time in the selected range in which to 

generate a report. If you select the schedule time 
for your report, the system converts the time 
that you choose to the Contact Center Manager 
Administration server time and gives the generated 
report the Contact Center Manager Administration 
server timestamp (if you choose a time zone 
other than the one in the Contact Center Manager 
Administration server).

Avaya recommends that you avoid starting reports 
on the hour, or on fifteen, thirty, or forty-five 
minutes after the hour. Instead, schedule reports 
five minutes after intervals, for example 07:05 or 
16:20.

Printing a report schedule
Before you begin

• Log on to Historical Reporting.

About this task
If you are an administrator logged on as webadmin, you can use the Scheduled Events window 
to print the schedules of all reports scheduled by you and all other users. Otherwise, you can use 
this window to print only the reports that you schedule.

Procedure
1. In the left pane, click the Scheduled Events folder. The list of scheduled reports appears.

2. In the right pane, select a report, and then click Print.
3. In the message box that appears, select one of the following options:

• Print: Click Print to print the entire list of scheduled reports shown in the window.

• Page Setup: Use the Page Setup option to select the paper size of the printed 
schedules. If you choose A4 or Letter size, the Schedule Type and Status columns 
do not appear on the print preview or the printed copy. If you choose Legal size, you 
can preview and print all the displayed grid columns.

• Print Preview: You can preview the report schedule.
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Activating a scheduled report
Before you begin

• Log on to Historical Reporting.
• Schedule at least one report.

About this task
When you first schedule a report, or when you deactivate a scheduled report, you must activate it 
to schedule the report again. You can activate a report in one of two ways:

• Click Activate in the Report Properties window while you view a saved, scheduled, but 
inactive report.

• Click Activate in the Scheduled Events window. If you log on as the administrative user 
webadmin, you can activate reports that another user schedules; if you log on as a user other 
than webadmin, you can activate only the reports that you schedule.

Procedure
1. In the left pane, click the Scheduled Events folder.

2. In the right pane, select the report to activate.

3. Click Activate.

The scheduled report activates and runs according to the specified schedule.

Deactivating a scheduled report
Before you begin

• Log on to Historical Reporting.
• Schedule and activate at least one report.

About this task
You must deactivate the report to pause the report run for an active scheduled report.
You must deactivate a report schedule before you change the report properties, or before you 
delete the scheduled report. To resume the report on schedule, you must reactivate the scheduled 
report after you make the changes.
You have two options to deactivate a scheduled report:

• In the Report Properties window while viewing a saved, scheduled, and activated report.
• In the Scheduled Events window. If you log on as the administrative user, webadmin, you can 

deactivate reports that another user schedules; if you log on as a user other than webadmin, 
you can deactivate only those reports that you schedule.

This procedure shows you how to deactivate a report from the Scheduled Events window.
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Procedure
1. In the left pane, click the Scheduled Events folder.

2. In the right pane, select the scheduled report to deactivate.

3. Click De-Activate.

Selecting the network sites for a network-consolidated 
report

Before you begin
• You must select at least one network site to run a network nodal consolidated report. You see 

only the selected sites data in the report.

About this task
When you generate reports on the Network Control Center (NCC), you must specify the sites in 
the network to include in the report output by choosing them in the Selection Criteria area in 
the Report Properties window. You can define the selection criteria for public, private, and shared 
reports that you schedule or generate on demand.

Procedure
1. In the left pane, click the NCC server that contains the report for which to define selection 

criteria.

2. Expand the folder that contains the report template to use.

Note:

If you click the Public Report Templates folder, you can see only the NCC folder.

3. In the expanded folder, select the report to use.

4. In the right pane, click the Selection Criteria heading.

5. Click the Available heading.

6. In the Available table, select the check box for each site to include in the report, and then 
click Update Selection Criteria.

The sites move to the Selected table.

7. To remove sites from the report, clear the check boxes for each site to remove, and then 
click Update Selection Criteria.

The sites move back to the Available table.

8. Click Run Now to generate the report.

9. To save your changes, in the Save As box, type a report name, choose a save location, 
and click Save Report.
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Running a report from a different time zone
Before you begin

• Log on to Historical Reporting. For information, see Logging on to Historical reporting on 
page 80.

About this task
You can select the time zone to run an on-demand report or schedule a report. The time zone that 
you select applies to the data range of the report and the report schedule. You can choose the 
time zone to appear in:

• the current computer time zone
• the Contact Center (server) time zone
• any other time zone

Procedure
1. In the left pane, select the server that contains the report to run.

2. In the expanded list, double-click the folder that contains the report to run.

3. Select the report to run.

4. In the right pane, click Report Details.
5. In the Time Zone field, select a time zone.

6. Click Run Now to generate the report.

Deleting a report
Before you begin

• Log on to Historical Reporting.
• Deactivate the schedule. See Deactivating a scheduled report on page 96.

About this task
You can delete reports from your private report templates folder and reports in your group folder 
that you create. You cannot delete public reports or shared reports that other users in your group 
create.
Your CCMA administrator can delete reports of other users from the shared report groups. 
Deletions appear in the in the Audit Trail log.

Procedure
1. In the left pane, click the server from which to delete the report.

The server appears to reveal a choice of Public, Private, and Group folders (if you have 
access to a group).
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2. Navigate to the report to delete.

3. Right-click the report, and then click Delete.

4. In the confirmation dialog box, click Yes.
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Chapter 11: Expert reports

You can create custom or expert reports in an ODBC or JDBC compliant application. This chapter 
describes how to create basic reports in Microsoft SQL Server Report Builder and import them into 
Contact Center Manager Administration. It also provides general instructions for creating reports in 
other applications.

Contact Center supports the Microsoft Report Definition Language (RDL) format. To build report files 
in this format, the preferred software package is Microsoft SQL Server Report Builder.

Before creating custom reports, ensure that you have an understanding of SQL SELECT 
statements, the Contact Center database schema, and Contact Center Historical Reporting.

Installing the Caché ODBC driver CCMS
Before you begin
Ensure you have the most recent version of the Contact Center DVD.

About this task
To run custom reports or SQL queries from client computers you must first install an Intersystems 
Caché ODBC driver on the client computer. This Intersystems Caché ODBC driver is available on 
the Avaya Aura® Contact Center Installation DVD.
You can install a 32–bit or 64–bit driver, depending on the operating system of your client 
computer and the application using the ODBC driver. Ensure that you install the driver on the 
client computer only, not on the Contact Center server.

Procedure
1. Insert the Contact Center DVD into your client computer.

2. Navigate to the ThirdPartySoftware\IntersystemsCache\CacheODBCDrivers\ 
folder.

3. Double-click the Intersystems Caché ODBC driver application (for example, 
cache.2015.1.0.ODBCDriver_x86.exe).

4. Click Next on the InstallShield Wizard for the Intersystems ODBC driver.

5. Click Install to install the driver.

6. When the driver is installed, click Finish.

September 2025 Using Avaya Aura® Contact Center Reports and Displays 100
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingAvayaAura%C2%AE%E2%80%8EContactCenterReportsandDisplays&p3=27


Defining the Caché ODBC DSN for CCMS
Before you begin
Make sure the Intersystems Caché port 1972 is open in the client computer firewall.
Select a desktop user account that the DSN uses to log into the Contact Center Manager Server 
database. If needed, ask an administrator for the account details. For more information on adding 
desktop user accounts, see Avaya Aura® Contact Center Server Administration.

About this task
To access the Contact Center Manager Server database, you must define a connection to the 
server and define the Caché ODBC DSN. The name of the Caché ODBC DSN for CCMS must 
begin with CCMS_.

Procedure
1. On the client computer, click Start > Run.

2. In the Open box:

• If the operating system and ODBC driver are both 32–bit or 64–bit, type 
C:\Windows\System32\odbcad32.exe

• If the operating system is 64–bit and the ODBC drivwer is 32–bit, type 
C:\Windows\SysWOW64\odbcad32.exe

3. Click OK.

4. Click the System DSN tab.

5. Click Add.

6. Select Intersystems ODBC.

7. Click Finish.

The system displays the Intersystems Cache ODBC Data Source Setup dialog.

8. In the Name box, enter the required name of the DSN. For example, type 
CCMS_PREVIEW_DSN.

9. In the Description box, enter a description of the DSN.

10. In the Host box, enter the IP address or computer name of the Contact Center server.

11. In the Port box, confirm that the port number is 1972.

12. In the Cache Namespace box, enter CCMS_STAT.

13. In the User Name box, type the user name of the desktop user account.

14. In the Password box, type the password of the desktop user account.

15. Click Test Connection to test the connection.

16. Click OK.

Defining the Caché ODBC DSN for CCMS
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Defining the DSN for CCMM
Before you begin
Ensure the Intersystems Caché port 1972 is open in the client computer firewall.
Ensure that you know the reporting credentials of the CCMM reporting user. You configure this 
account using CCMM Administration.

About this task
To access the Contact Center Multimedia database from a report writer application, you must 
install the Caché ODBC driver and define the DSN. The name of the Caché ODBC DSN for 
CCMM must begin with CCMM_.

Procedure
1. On the client computer, click Start > Run.

2. In the Open box:

• If the operating system and ODBC driver are both 32–bit or 64–bit, type 
C:\Windows\System32\odbcad32.exe

• If the operating system is 64–bit and the ODBC drivwer is 32–bit, type 
C:\Windows\SysWOW64\odbcad32.exe

3. Click OK.

4. Click the System DSN tab.

5. Click Add.

6. Select Intersystems ODBC.

7. Click Finish.

The system displays the Intersystems Cache ODBC Data Source Setup dialog.

8. In the Name box, enter the required name of the DSN. For example, type 
CCMM_PREVIEW_DSN.

9. In the Description box, enter a description of the DSN.

10. In the Host box, enter the IP address or computer name of the Contact Center Multimedia 
server.

11. In the Port box, confirm that the port number is 1972.

12. In the Cache Namespace box, enter MULTIMEDIA.

13. In the User Name box, type the user name of the desktop user account. For example, type 
mmReport.

14. In the Password box, type the password of the desktop user account. For example, type 
mmRep.

15. Click Test Connection.
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16. Click OK.

Installing the Caché JDBC driver
About this task
Contact Center supports JDBC connectivity to the CCMS database.

Procedure
1. Log on to the server with CCMS installed.

2. Navigate to the CCMS installation directory. If you select the default installation options 
then CCMS is normally installed at: D:\avaya\Contact Center.

3. Navigate to the following default folder: D:\avaya\Contact Center\Common 
Components\Cache\lib\.

4. Copy the cacheDB.jar file from this location to the client computer.

5. The JDBC url is jdbc:Cache://127.0.0.1:1972/CCMS_STAT on the server. When 
accessing this URL from the client computer, replace 127.0.0.1 with the IP address of 
the server.

6. Use the database user name and password to connect to the server.

Running the Database View Definition report
About this task
Before you create a customized report, run the Database View Definitions report to display all the 
database views available. This report lists all of the field names available for use in your report.
The Database View Definition report does not include views from the Contact Center Multimedia 
database.

Procedure
1. On the CCMA launchpad, click on Historical Reporting.
2. Select the Contact Center Manager Server from which to run the report.

3. Select the Configuration folder in Public Report Templates.

4. Select Config - Database View Definitions.

5. Click Run Now to generate the report.

6. Click the Printer icon if you require a printout, or the Export icon to save the report.
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Creating a new report
Before you begin

• Ensure that you know how to use Microsoft SQL Server Report Builder. If you have questions 
about this Report Builder tool, contact your Microsoft vendor.

• You must have a user ID and password for the Contact Center Manager Administration 
server. Contact your system administrator for this information.

About this task
Use Report Builder to create a new report. The report must be based on Contact Center database 
data.
This procedure uses an example to show how to create a new expert report. The example report 
in this procedure uses the following details:

• ODBC Connection: CCMS_PREVIEW_DSN
• View: dAgentPerformanceStat
• Fields:

- Timestamp
- AgentLogin
- AgentGivenName
- AgentSurName
- CallsOffered
- CallsAnswered
- LoggedInTime
- TalkTime
- HoldTime
- PostCallProcessingTime
- NotReadyTime
- WaitingTime

For more detailed information about the CCMS and CCMM database schemas and about the 
standard reports included in Historical Reporting, see Contact Center Performance Management 
Data Dictionary.
For complete details on creating custom reports, see the Custom Reports Application Note on 
https://support.avaya.com.

Procedure
1. Launch Report Builder.

2. On the Getting Started window, select New Report and click Blank Report.
3. To ensure that the Report Data tree view is visible, click Properties from the View menu.
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4. On the Report Data tree view, right-click Data Sources and select Add Data Source.

5. On the Data Source Properties window, in the Name field, type the data source name 
(DSN) on which you want to run the report.

For example, type CCMS_PREVIEW_DSN.

6. Select Use a connection embedded in my report.
7. In the Select connection type list, select ODBC.

8. Click Build.

9. On the Connection Properties window, select Use user or system data source name and 
then select the DSN from the list.

For example, select CCMS_PREVIEW_DSN from the list.

10. Click OK to return to the Data Source Properties window.

11. Click the Credentials tab.

12. Select Prompt for credentials and then type appropriate text to display when the report 
runs.

For example, type Specify credentials for CCMS_PREVIEW_DSN.

13. Click OK.

14. In the Report Data tree view, right-click Datasets and select Add Dataset.

The Dataset Properties window is displayed.

15. In the Name field, type a name for the view.

For example, type dAgentPerformanceStat.

16. Select Use a dataset embedded in my report.
17. From the Data source list, select CCMS_PREVIEW_DSN.

18. Under Query type, select Text.
19. In the Query field, type the query that you want to run for this report.

For example, type the following:
SELECT TOP 100
MIN(dAgentPerformanceStat.Timestamp) AS Timestamp,
MIN(LTRIM(dAgentPerformanceStat.AgentLogin)) AS AgentLogin,
MIN(LTRIM(dAgentPerformanceStat.AgentSurName)) AS AgentSurName,
MIN(LTRIM(dAgentPerformanceStat.AgentGivenName)) AS AgentGivenName,
SUM(dAgentPerformanceStat.CallsOffered) AS CallsOffered,
SUM(dAgentPerformanceStat.CallsAnswered) AS CallsAnswered,
SUM(dAgentPerformanceStat.LoggedInTime) AS LoggedInTime,
SUM(dAgentPerformanceStat.TalkTime) AS TalkTime,
SUM(dAgentPerformanceStat.HoldTime) AS HoldTime,
SUM(dAgentPerformanceStat.PostCallProcessingTime) AS PostCallProcessingTime,
SUM(dAgentPerformanceStat.NotReadyTime) AS NotReadyTime,
SUM(dAgentPerformanceStat.WaitingTime) AS WaitingTime
FROM dbo.dAgentPerformanceStat dAgentPerformanceStat
WHERE (dAgentPerformanceStat.Timestamp>= DateAdd('d', -8, Now()) And 
dAgentPerformanceStat.Timestamp<= DateAdd('d', -1, Now()))

Creating a new report

September 2025 Using Avaya Aura® Contact Center Reports and Displays 105
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingAvayaAura%C2%AE%E2%80%8EContactCenterReportsandDisplays&p3=27


GROUP BY dAgentPerformanceStat.Timestamp, dAgentPerformanceStat.AgentLogin
ORDER BY dAgentPerformanceStat.Timestamp, dAgentPerformanceStat.AgentLogin

20. Click OK.

21. On the Enter Data Source Credentials window, type the username and password the 
report uses to access the DSN.

22. Click the Insert menu.

23. Click the Table icon and select Table Wizard.

24. On the Choose a dataset page, select the view you created earlier (for example, 
dAgentPerformanceStat) and then click Next.

25. On the Arrange fields page, move items from the Available fields field as required.

For example, move the following to Row groups:

• AgentLogin

• Timestamp

Then move the following to Values:

• LoggedInTime

• TalkTime

• HoldTime

• PostCallProcessingTime

• NotReadyTime

• WaitingTime

• CallsOffered

• CallsAnswered

26. Click Next.
27. On the Choose the layout page, select Show subtotals and grand totals.

28. Select Stepped, subtotal above.

29. Clear Expand/collapse groups.

30. Click Next.
31. On the Choose a style page, select a style from the Styles list.

32. Click Finish.

33. In the Report Data tree view, right-click Parameters and select Add Parameter.
34. On the Report Parameter Properties window, click the General tab

35. In the Name field, type a name for the filter.

For example, type report_rowfilter_dAgentPerformanceStat.
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36. In the Data type list, select Text.
37. Select Allow null value.

38. In the Select parameter visibility list, select Internal.
39. Click the Available Values tab.

40. In the Select from one of the following options list, select Specify values.

41. Click ADD, and enter Default in both the Label field and the Value field.

42. Click ADD, and enter TableAlias in the Label field and an asterisk (*) in the Value field.

43. Click ADD, and enter FieldName in the Label field and an asterisk (*) in the Value field.

44. Click the Default Values tab.

45. In the Select from one of the following options list, select Specify values.

46. Click ADD, and enter Default in the Value field.

47. Click OK.

48. In the Report Data tree view, right-click Parameters and click Add Parameter to display 
the Report Parameter Properties window.

49. Click the General tab

50. In the Name field, type a name for the report query.

For example, type report_query_dAgentPerformanceStat.

51. In the Data type list, select Text.
52. Select Allow null value.

53. In the Select parameter visibility field, select Internal.
54. Click the Available Values tab.

55. In the Select from one of the following options list, select Specify values.

56. Click ADD, and enter Default in both the Label field and the Value field.

57. Click ADD, and enter All in the Label field.

58. Click fx beside the Value field.

59. In the Set expression for: Value field, type the query text.

For example:
SELECT
MIN(dAgentPerformanceStat.Timestamp) AS Timestamp,
MIN(LTRIM(dAgentPerformanceStat.AgentLogin)) AS AgentLogin,
MIN(LTRIM(dAgentPerformanceStat.AgentSurName)) AS AgentSurName,
MIN(LTRIM(dAgentPerformanceStat.AgentGivenName)) AS AgentGivenName,
SUM(dAgentPerformanceStat.CallsOffered) AS CallsOffered,
SUM(dAgentPerformanceStat.CallsAnswered) AS CallsAnswered,
SUM(dAgentPerformanceStat.LoggedInTime) AS LoggedInTime,
SUM(dAgentPerformanceStat.TalkTime) AS TalkTime,
SUM(dAgentPerformanceStat.HoldTime) AS HoldTime,
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SUM(dAgentPerformanceStat.PostCallProcessingTime) AS PostCallProcessingTime,
SUM(dAgentPerformanceStat.NotReadyTime) AS NotReadyTime,
SUM(dAgentPerformanceStat.WaitingTime) AS WaitingTime
FROM dbo.dAgentPerformanceStat dAgentPerformanceStat
{?report_rowfilter_dAgentPerformanceStat}
GROUP BY dAgentPerformanceStat.Timestamp, dAgentPerformanceStat.AgentLogin

60. Click OK.

61. Click the Default Values tab.

62. In the Select from one of the following options list, select Specify values.

63. Click ADD, and enter Default in the Value field.

64. Click OK.

65. Save the report, specifying a name for the report file.

For example, save the report as AgentPerformance.rdl.

Next steps
Test the report. When the report loads, ensure that it is displayed correctly.

Testing exported reports
About this task
Export a report in one of the supported output formats and view the exported report. The 
supported formats are PDF, Microsoft Excel, or Microsoft Word format.

Procedure
1. Open the report.

2. On the Home tab, click the Run icon.

3. Type the username and password for the report connection, if required.

4. Click the Export icon.

5. Save the file to a known location using one of the supported output formats.

6. Navigate to the save location and open the exported file.

7. Review the exported report and ensure that the format is correct.

Importing a custom report
Before you begin
Log on to Historical Reporting. For more information, see Logging on to Historical reporting on 
page 80.

Expert reports
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About this task
After creating reports in Microsoft SQL Server Report Builder, use the Report Template Importing 
Wizard to import your reports into Contact Center Manager Administration. You can import 
historical or configuration reports.
When you import a report template, you save it on the Contact Center server. You can access the 
report template from your Private Report Templates folder. To share the report template with other 
users, save your private report in your Group folder (if you have access to a group folder).

Procedure
1. In the left pane, click the server to import the new report template.

2. From the Report menu, click Import.

Contact Center displays the Report Template Importing Wizard window.

3. Click Browse next to the Select Your Report template field and navigate to the report.

4. In the Template Name field, type the name of the report to import.

5. From the Report is based on the following data list, select a report type.

6. If applicable, provide database alias, timestamp, and report data range details.

7. Select the Synchronize report template from the network drive check box to 
synchronize reports.

If you do not select this check box, Contact Center Manager Administration ignores the 
report in step 9.

8. Click Import.

The wizard prompts you to import your report template to the server. Perform steps 1 to 8 
for all your custom report templates.

9. From the CCMA Administration menu, click Report > Synchronize User Imported 
Report Templates.

10. Read the warning message indicating that there are no scheduled or ad hoc reports 
running.

11. Click Submit to finish synchronizing all report templates from step 7.

For a successful synchronization, the iceAdmin domain account must have the Read 
permission on the network folder. Contact Center Manager Administration uses this 
account, configured in the iceAdmin Password Change tool, to synchronize the report 
templates.

Importing a custom report
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Creating reports using Microsoft Excel
About this task
If the Contact Center supports importing data using ODBC, you can use a program such as 
Microsoft Excel to create reports. After creating the report, you can format and print the imported 
data.
The steps in this procedure might vary depending on which version of Excel you are using.

Procedure
1. Open Microsoft Excel.

2. Click Data > From Other Sources > From Data Connection Wizard.

3. In the Data Connection Wizard window, select ODBC DSN.

4. Click Next.
5. Select the ODBC entry defined for the server.

6. Click Next.
7. Select the table to create.

8. Click Next.
9. To save the table, in File Name, type a file name.

10. Click Finish.

11. In the Import Data dialog box, specify how and where to view the data.

12. Click OK.

Variable definitions
Variable Value
ODBC entry Server application name and IP address (for 

example, CCMS_47.10.25.3_DSN).

Creating reports using Microsoft Access
About this task
You can create reports in an application that supports importing data using ODBC.
This procedure describes how to create reports in Microsoft Access. The exact steps might vary 
depending on which version of the application you are using.

Procedure
1. Open Microsoft Access.

Expert reports
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2. Open an existing database file or create a new blank database.

3. Select External Data > ODBC Database.

4. On the Get External Data — ODBC Database window, select Import the source data into 
a new table in the current database.

5. Click OK.

6. In the Select Data Source window, click the Machine Data Source tab.

7. Select the ODBC entry defined for the server.

8. Click OK.

9. If required, enter the login ID and password.

10. Click OK.

11. On the Import Objects window, select the tables to import into the Microsoft Access 
database.

12. Click OK.

You can now use the features available in Microsoft Access to format the imported data 
and to create reports. The time to import the data depends on the amount of data stored in 
the selected tables.

Variable definitions
Variable Value
ODBC entry Server application name and IP address (for 

example, CCMS_47.10.25.3_DSN).

Creating reports using Microsoft Access
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Chapter 12: Statistics configuration

The Report Creation Wizard includes a number of formulas that you can use when you create 
reports. In addition, you can define custom formulas. After you define a formula, you can use it in 
multiple reports.

Prerequisites to statistics configuration
Ensure that you are familiar with the Formula Editor.

Creating custom formulas
About this task
Use the Formulas window to create custom real-time statistics fields by combining existing 
statistics fields with mathematical operators. You can then save these custom statistics fields 
as formulas and use the formulas in your private Real-Time Reporting displays. For example, you 
can create a custom formula to calculate the service level.

Procedure
1. Log on to the Configuration component.

2. In the left pane, click the server on which to create the formula.

3. Select the Formulas folder.

4. In the right pane, in Available Formulas box, type the name of the new formula.

5. From the Statistics Group list, select the statistics group that contains the statistics field to 
include in your formula.

6. Press Enter to display the Formula Editor.
7. (Optional) In the Comment box, type information about the formula.

8. From the Variables list, select the variable to use in the formula.

The variable appears in the Formula box. When you select a variable, it appears in the 
Formula box with a percent symbol (%) preceding it. The percent symbol identifies it as a 
variable; it is not a mathematical operator.
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9. On the numeric keypad, press a number to apply to the formula.

10. After you select a mathematical operator, you can select another variable to add to the 
formula.

11. To use the higher or lower of two values in your formula, click Max or Min.

12. After you create the formula, click Save.

13. Click Close to close the Formula Editor.

Variable definitions
Variable Definition
Available Formulas A list of names for the custom formulas.

To edit an existing formula, double-click the 
formula name in the Available Formulas column. 
The Formula Editor appears, listing the Formula 
components.

Statistics Group Statistics groups are sets of related statistics 
defined in the database, such as agent statistics or 
skillset statistics.

Formula Name The name of the formula you enter in the Available 
Formulas box in the Formulas window. You can 
change formula name in the Formula Editor.

Comment Type additional information about your custom 
formula. Click Save to save your changes.

Formula The variables and mathematical operators that you 
choose for your custom formula. You can add new 
variables and operators, or edit the existing ones. 
Click Save to save your changes.

Variables The existing statistics fields that you can combine to 
create custom formulas. After you create a formula, 
you can apply it to your private Real-Time Reporting 
displays to control the type of data that you see.

From the Variables list, select the variables to add 
to your custom formula. After you select a variable, 
you must choose a mathematical operator (/, *, -, or 
+) before you can select another variable, or before 
you can enter a numeric value.

When you select a variable, it appears in the 
Formula box with a percent symbol (%) preceding 
it. The percent symbol identifies it as a variable; it is 
not a mathematical operator.

Table continues…
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September 2025 Using Avaya Aura® Contact Center Reports and Displays 113
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingAvayaAura%C2%AE%E2%80%8EContactCenterReportsandDisplays&p3=27


Variable Definition
Numeric keypad Add mathematical operators and numeric values to 

your custom formulas.

• Back Space: Removes the last item that you 
enter in your formula. To remove more items, you 
must click C to clear the entire formula.

• C: Clears the entire formula from the Formula 
box.

• /: Divides the variables in the formula.

• *: Multiplies the variables in the formula.

• -: Subtracts the variables in the formula.

• +: Adds the variables in the formula.

• ,: Separates the Max and Min variables in the 
formula.

After each variable, you must select a mathematical 
operator before you select another variable.

Max and Min Use the higher of two values (Max), or the lower of 
two values (Min) in your formula.

When you click Max or Min, brackets appear in the 
Formula box. In these brackets, add the two values 
to compare, separated by a comma.

The format must be as follows: Max[a,b]: a can 
be one variable, or two variables separated by 
an operator, and b can be one variable, or two 
variables separated by an operator.

For example, for the following formula 
Max[Agent_Available+Agent_Not_Ready, 
Agent_In_Service+Agent_On_This_Skillse
t_Call], the system calculates the values for 
Agent_Available+Agent_Not_Ready and 
for 
Agent_In_Service+Agent_On_This_Skillse
t_Call, and uses the higher of the two values in 
the formula. If you use Min in this example, the 
system calculates the lower of the two values.

Save Save changes you make in the Formula Editor.
Close Exit the Formula Editor.

To save your changes, click Save before you close 
the Formula Editor.
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Example of creating a custom formula
About this task
You can create a formula for a service level. The formula can be up to 250 characters.

Procedure
1. In the Available Formulas box, type CallsAnswered.

2. From the Statistics Group list, select Application.

3. Press Enter.
4. In the Formula Editor, from the Variables list, select Calls_Answered.

5. On the numeric keypad, click the subraction symbol (-).
6. From the Variables list, select Calls_Answd_Aft_Threshold.

7. On the numerical keypad, click the division symbol (/).
8. From the Variables list, select Calls_Answered.

9. Click Save.

10. Click Close.

Modifying custom formulas
About this task
Modify custom formulas to update previously created custom formulas.

Procedure
1. Log on to the Configuration component.

2. On the system tree in the Configuration component, double-click the server containing 
the formula to modify.

3. Select the Formulas folder.

4. In the Available Formulas column, double-click the name of the formula to edit.

5. To add a new variable, in the Formula Editor, click an operator (/,*,–,+).

6. In the Variables list, select a new variable.

7. To delete an element from the formula, in the Formula box, select the element.

8. Press Delete.

9. Click Save.

Modifying custom formulas
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Deleting a custom formula
About this task
Delete formulas you no longer require.
If you delete a formula that you use in a real-time display, the column in the display appears blank.

Procedure
1. Log on to the Configuration component.

2. On the system tree, in the Configuration component, double-click the server containing 
the formula to delete.

3. Select the Formulas folder.

4. In the table, select the formula to delete.

5. Press Delete.

6. In the confirmation dialog box, click Yes.

Configuring historical statistics data collection
About this task
You can configure the following historical statistics collection options:

• the general system parameter values, such as the number of skillsets
• the type of call flow, agent, and IVR historical statistics to collect
• the collected applications for call-by-call data
• the length of time that historical statistics remain on Contact Center Manager Server

You must calculate the amount of required disk space to run your selected configuration and 
specify the first business day of the week.

Procedure
1. Log on to the Configuration component.

2. In the left pane, click the server on which to configure historical statistics.

3. Select the Historical Statistics folder.

4. In the Parameters table, for each parameter, type the value to configure, ensuring that 
the value is less than or equal to the purchased value, and greater than or equal to the 
measured value.

You must consider future growth while choosing a value.

5. In the Collect the following statistics table, for each statistic type, in the Collect column, 
select the check box for each statistic to collect.

Statistics configuration
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6. In the Call-by-Call table, for each application, from the Statistics Collection Method list, 
select the type of calls for which to collect call-by-call statistics.

7. In the Duration table, for each type of statistic, enter the amount of time the statistic is 
stored on the server. Note that the time units vary depending on the statistic. The limit 
for each statistic, with the exception of the Length of Business day and Business week 
contains statistics, is 1825 time units (days, weeks, or months).

Caution:

When you reduce the duration of a statistic, Contact Center purges all data for that 
statistic that is older than the new duration specified.

8. From the Business week starts list, select the day on which to accumulate weekly 
statistics.

9. Click Calculate to determine if you have sufficient disk space available for the selected 
historical statistics collection configuration.

The disk space requirements for the selected configuration appear in the Call-by-Call 
Database, CSR Database, and System Database Required boxes. The available disk 
space appears in the Call-by-Call Database, CSR Database, and System Database 
Actual boxes.

10. Click Submit to save your changes.

Note:

If the disk space required is greater than the disk space available, you must lower the 
number of days the data is stored, or you must change the number of estimated calls 
for each hour until sufficient disk space exists for your configuration.

Configuring historical statistics collection on the NCC
Before you begin

• Ensure that the number of days to store network call-by-call data is synchronized with the 
Historical Statistics Configuration for each server in the network. See Configuring historical 
statistics data collection on page 116.

About this task
You can choose the length of time to store network call-by-call statistics on the Network Control 
Center (NCC). Your configuration determines the following items:

• the amount of data included in your network call-by-call reports
• the amount of disk space required on the NCC

Procedure
1. Log on to the Configuration component.

Configuring historical statistics collection on the NCC
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2. In the left pane, click the NCC server.

3. Click the Network Historical Statistics folder.

4. In the right pane, in the Keep Network Call-by-Call data for box, type the number of days 
to store network call-by-call data on the NCC.

5. In the Network call rate box, type the estimated number of calls networked out for each 
hour (routed from one site to another).

6. Click Submit to calculate the disk space that the call-by-call database requires for your 
configuration.

The required disk space appears in the Required text box. The available disk space 
appears in the Actual text box.

Note:

If the disk space required is greater than the disk space available, you must lower the 
number of days the data is stored, or you must change the number of estimated calls 
for each hour until sufficient disk space exists for your configuration.

Configuring real-time statistics collection
About this task
To use the Real-Time Reporting feature of Contact Center Manager Administration, you must first 
configure Contact Center Manager Server to collect the types of statistics to view in the Real-Time 
Reporting displays. You can configure the following seven types of predefined real-time statistics:

• skillset statistics (mandatory)
• nodal statistics (mandatory)
• application statistics
• IVR statistics (Avaya Communication Server 1000)
• route statistics (Avaya Communication Server 1000 PABX only)
• agent statistics
• network statistics (Avaya Communication Server 1000 PABX only)

For each of these real-time statistics, you must indicate the viewing mode (moving window or 
interval-to-date). The interval-to-date settings that you choose start immediately, and apply to all 
real-time displays at all sites on your network that use the interval-to-date mode.

Note:
Agent interval-to-date statistics are collected only until the agent logs out, or until the end of 
the interval.
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Procedure
1. Log on to the Configuration component.

2. In the left pane, select the server on which to configure the real-time statistics.

3. Select the Real-time Statistics folder.

4. In the right pane, select the viewing mode for the following statistics:

• Skillset Statistics: You must select a viewing mode value for this statistic. The system 
automatically collects this required statistic for Intrinsics in writing scripts.

• Nodal: You must select a viewing mode value for this statistic. The system automatically 
collects this required statistic for Intrinsics in writing scripts.

• Application Statistics: Optional.

• IVR Statistics: Optional.

• Route Statistics: Optional. Available on an Avaya Communication Server 1000 PABX 
only.

• Agent Statistics: Optional.

• Network Statistics: Optional. Available on an Avaya Communication Server 1000 
PABX only.

5. In the Data Collection Interval boxes, type the interval duration to use in the interval-to-
date data collection mode.

6. In the One of the intervals starts at box, type the start time for statistics collection in the 
interval-to-date data collection mode.

The system calculates and synchronizes the days remaining intervals based on the time 
that you specify. Your changes take effect immediately.

7. Click Submit to save your changes.

Configuring real-time statistics collection
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Chapter 13: Report Creation Wizard

Report Creation Wizard is a Web-based interface in which you can create and edit reports. You can 
import and schedule the reports in Historical Reporting. You can access the Report Creation Wizard 
from the Historical Reporting component of Contact Center Manager Administration.

Note:

If the Report Creation Wizard window is open and a High Availability switchover occurs, the 
session is not maintained and you must relaunch Report Creation Wizard to continue operation.

Starting Report Creation Wizard
Before you begin

• Ensure that you have a license for Report Creation Wizard.

About this task
To access Report Creation Wizard, start this application.

Procedure
1. Log on to Contact Center Manager Administration.

2. From the Launchpad, click Historical Reporting.

3. In the left pane, click the Contact Center Manager Server on which to create, edit, or view 
the Report Creation Wizard report.

4. From the Report menu, select Report Creation Wizard.

Opening an existing report
Before you begin

• Start Report Creation Wizard. See Starting Report Creation Wizard on page 120.
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About this task
Select the Open Existing Report option to open an existing report. After you select this option, a 
navigation tree appears. Navigate to the report to open. You can choose from previously created 
reports or from a list of sample reports.

Procedure
1. From the Report Type window, select the Open Existing Report option.

2. Click the folder that contains the report to open.

3. From the list of reports, select the report.

4. Click Next.

Creating a simplified report
Before you begin

• Start Report Creation Wizard. See Starting Report Creation Wizard on page 120.

About this task
Select the Create Simplified Report (via Report Definitions) option to use one of the report 
definitions available with Report Creation Wizard.
If you choose to create a simplified report, you can choose from a list of standard report definitions 
in the Data Source window. The Data Source window lists the available report definitions based on 
the server type selected. If the Contact Center is multimedia enabled, multimedia report definitions 
are also available.

Procedure
1. In the Report Type window, select the Create Simplified Report (via Report Definitions) 

option.

2. In the Data Source window, click the Report Definitions folder.

3. Navigate to the folder that contains the report definition to open.

4. Click Next.
5. In the Field Selection window, in the Fields list, double-click a field or formula to add to the 

report.

The selected field or formula is moved from the Fields list to the Fields Selected list.

By default the table name is appended to the field name after you add the field to the 
Fields Selected list. To remove the table name, click the Toggle Table Name icon.

Note:

If you remove a field from the Field Selection page, the field is removed only from the 
Details section, not from any other section.
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6. To change the order of the selected fields, use the up and down arrows.

7. To modify the properties of a selected field, in the Selected Fields list, click a field, and 
then in the Width box, type a new width.

A default width of 80 pixels applies to all selected fields. The Title box is a read-only field.

8. Click Next.
9. To select a field to group by, in the Grouping window, from the Fields list, double-click a 

field or formula.

The selected field or formula moves to the Group by list.

10. To accept the default properties of the selected fields and formulas, proceed to step 23 on 
page 122.

11. To modify the properties of a group field, from the Group by list, select a field.

12. From the Sort Order list, select a sort order.

13. From the The section will be printed list, select a length of time that defines when the 
group changes.

Note:

This option is available only for Date, Time, and DateTime fields. It determines when 
the group prints. For example, selecting for each hour groups records together for 
each hour, and calculates group summaries for each hour.

14. Click Next.
15. In the Summaries window, from the Fields list, select a field.

16. From the Summation Type list, select a summation type.

As you select the fields in the Fields list, the Summation Type list dynamically updates to 
show the types available for the selected field.

17. From the Groups list, select the check box for each report section in which the summary 
appears on the report.

18. Click Add.

The summary appears in the Summary Data list.

19. Click Next.
20. In the Report Layout window, view or modify the report.

21. On the toolbar, click the Save Report icon.

22. In the Save RCW Report dialog box, choose a folder in which to save the report.

23. In the Report Name box, enter a name for the report.

24. Click Save.

You can save the report after you select at least one field.
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Example of creating a sample simplified Agent by Skillset 
Performance report

About this task
You can create various report types, such as an Agent by Skillset Performance report.

Procedure
1. In the Report Type window, select the Create Simplified Report (via Report Definitions) 

option.

2. Click Next.
3. In the Data Source window, under the Report Definitions folder, expand the CS1000 

folder, and then expand the Agent Performance folder.

4. In the Agent Performance folder, select the Agent By Skillset Performance Stats report 
definition.

5. Click Next.
6. In the Field Selection window, from the Fields list, expand the iAgentBySkillsetStat 

heading.

7. From the iAgentBySkilsetStat list, double-click the following fields in the order listed:

• Skillset
• Timestamp
• Time
• AgentLogin

8. From the Fields list, expand the iAgentBySkillsetStat Formulas heading.

9. From the iAgentBySkillsetStat Formulas list, double-click RCW_AgentName.

10. From the iAgentBySkillsetStat Formulas view, double-click CallsAnswered.

11. In the iAgentBySkillsetStat Formulas list, double-click RCW_TalkTime.

Each selected field and formula moves from the Fields list to the Fields Selected list.

12. Change the width for the following selected fields:

Selected field Width
iAgentBySkillsetStat.Skillset 200
iAgentBySkillsetStat.Timestamp 200
iAgentBySkillsetStat.AgentLogin 80
iAgentBySkillsetStat.RCW_AgentName 120
iAgentBySkillsetStat.CallsAnswered 80
iAgentBySkillsetStat.RCW_TalkTime 80

13. Click Next.
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14. In the Grouping window, from the Fields list, expand the iAgentbySkillsetStat heading, 
and then double-click the following fields to group by:

• Skillset
• Timestamp (represents the date and time)

Each selected field moves from the Fields list to the Group by list.

The RCW_TalkTime formula is not available because it is a dynamic formula.

15. From the Group by list, select iAgentbySkillsetStat.Timestamp.

16. From the This section will be printed list, select for each hour.

Note:

This option is available only for Date, Time, and DateTime fields and defines when the 
group changes.

17. Click Next.
18. In the Summaries window, from the Fields list, expand the iAgentBySkillsetStat heading.

19. From the iAgentBySkillsetStat, select CallsAnswered.

20. From the Summation Type list, select Sum.

21. From the Groups list, select the following check boxes:

• Report Footer
• Group Footer #1
• Group Footer #2

22. Click Add.

A CallsAnswered summary for the Report Footer, Group Footer #1, and Group Footer 
#2 appears in the Summary Data list.

Footer 1 generates a total for all data selected, Group Footer 1 generates a total for each 
selected skillset, and Group Footer 2 generates a total for each selected timestamp.

23. From the Fields list, expand the iAgentBySkillsetStat Formulas heading.

24. From the iAgentBySkillsetStat Formulas list, select RCW_TalkTime.

25. From the Groups list, select the following check boxes:

• Report Footer
• Group Footer #1
• Group Footer #2

26. Click Add.

An RCW_TalkTime summary for the Report Footer, Group Footer #1, and Group 
Footer #2 appears in the Summary Data list.

Report Creation Wizard

September 2025 Using Avaya Aura® Contact Center Reports and Displays 124
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingAvayaAura%C2%AE%E2%80%8EContactCenterReportsandDisplays&p3=27


Footer 1 generates a total for all data selected, Group Footer 1 generates a total for each 
selected skillset, and Group Footer 2 generates a total for each selected timestamp.

27. Click Next.
28. In the Report Layout window, double-click the Group Footer #1 section.

The section bar changes color from blue to purple and expands to reveal the summary 
fields in this section.

29. In the Group Footer #1 section, click CallsAnswered.

The Object Properties page appears on the left.

30. On the Object Properties page, in the Width box, type 80.

31. In the Group Footer #1 section, click RCW_TalkTime.

32. On the Object Properties page, in the Width box, type 80.

33. Double-click the Group Footer #2 section.

34. In the Group Footer #2 section, modify the following Object Properties:

Group Footer #2 field Width
CallsAnswered type 80
RCW_TalkTime type 80

35. Double-click the Report Footer section.

36. In the Report Footer section, modify the following Object Properties:

Report Footer field Width
CallsAnswered type 80
RCW_TalkTime type 80

37. Click the Group Footer #1 section.

38. Click the Add Text Field icon on the toolbar.

39. On the Object Properties page, modify the following properties:

• In the Title box, type Skillset.

• In the Width box, type 80.

• In the Height box, type 20.

• In the Left box, type 300.

• In the Top box, type 3.

• From the Text Align list, select Right.
• Select the Bold check box.

40. Click the Group Footer #2 section.

41. Click the Add Text Field icon on the toolbar.
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42. On the Object Properties page, modify the following properties:

• In the Title box, type Timestamp.

• In the Width box, type 80.

• In the Height box, type 20.

• In the Left box, type 300.

• In the Top box, type 3.

• From the Text Align list, select Right.
• Select the Bold check box.

43. Click the Report Footer section.

44. Click the Add Text Field icon on the toolbar.

45. On the Object Properties page, modify the following properties:

• In the Title box, type Totals.

• In the Width box, type 80.

• In the Height box, type 20.

• In the Left box, type 300.

• In the Top box, type 3.

• From the Text Align list, select Right.
• Select the Bold check box.

46. Double-click the Page Header section.

47. In the Page Header section, click Time.

48. On the Object Properties page, modify the following properties:

• From the Font Color list, select Purple.

• Select the Underline and Bold check boxes.

49. In the Page Header section, modify the following Object Properties:

Page Header field Title Width Font Color Check boxes
AgentLogin Agent Login 80 Purple Bold

Underline
RCW_AgentName Agent Name 120 Purple Bold

Underline
CallsAnswered Calls Answered 80 Purple Bold

Underline
Table continues…
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Page Header field Title Width Font Color Check boxes
RCW_TalkTime Talk Time 80 Purple Bold

Underline

50. Double-click the Group Header #1 section.

51. In the Group Header #1 section, click Skillset.
52. On the Object Properties page, modify the following properties:

• From the Font Color list, select Blue.

• Select the Bold check box.

53. Double-click the Group Header #2 section.

54. In the Group Header #2 section, click Timestamp.

55. On the Object Properties page, modify the following properties:

• From the Font Color list, select Blue.

• Select the Bold check box.

56. On the toolbar, click Save.

57. In the Save RCW Report window, select a folder in which to save the report.

58. In the Report Name box, type Agent By Skillset Performance.rpt.

Note:

Avaya recommends that you use a name different from the standard report definitions 
to quickly identify custom reports and to determine the type of data the report 
generates.

59. Click Save.

Creating an advanced report
Before you begin

• Start Report Creation Wizard. See Starting Report Creation Wizard on page 120.
• Ensure that you are familiar with the Report Creation Wizard.
• Configure the DSNs on the Contact Center Manager Server.
• Ensure that you understand table linking and joins.

About this task
Select the Create Advanced Report (via ODBC) option to use an ODBC DSN. You can choose a 
combination of views from the data source. However, the views must include a common key field. 
This option provides the maximum flexibility, but it also requires that you understand the database 
structure with which you work.
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Procedure
1. In the Report Type window, select the Create Advanced Report (via ODBC) option.

2. In the Data Source window, from the DSNs Available list, double-click a DSN.

The selected DSN moves to the DSNs Selected list.

Note:

You can select only one DSN system type, for example, a CCMS or CCMM DSN.

3. The User ID and Password boxes automatically contain the values you enter during the 
server configuration.

You can change the user ID and password, but these changes apply only if you create 
the report. If you generate the report in Historical Reporting, Historical Reporting uses the 
values you enter during the server configuration.

4. Click Next.
5. In the Table Selection window, from the Tables Available list, double-click a table.

The table moves from the Tables Available list to the Tables Selected list.

6. To add another table, repeat step 5 on page 128.

7. Click Next.
8. If you select one table only, proceed to step 14 on page 128.

9. If you select more than one table, in the Table Linking window, from each of the left and 
right Tables lists, select a table.

10. From each of the left and right Fields lists, select a field to join.

Note:

The selected field in the right Fields list must contain the same data as the selected 
field in the left Fields list.

11. From the join list, select a join type and click Link.

The selected tables, field, and join type appear in the Links list.

12. To remove an item from the Links list, select the item and click Remove.

13. Click Next.
14. In the Field Selection window, in the Fields list, double-click a field or formula to add to the 

report.

The selected field or formula moves from the Fields list to the Fields Selected list.

By default the table name is appended to the field name after you add the field to the 
Fields Selected list. To remove the table name, click the Toggle Table Name icon.
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Note:

If you remove a field from the Field Selection page, the field is removed only from the 
Details section, not from any other section.

15. To change the order of the selected fields, use the up and down arrows.

16. To modify the properties of a selected field, in the Selected Fields list, click a field, and 
then in the Width box, type a new width.

A default width of 80 pixels applies to all selected fields. The Title box is a read-only field.

17. Click Next.
18. To select a field to group by, in the Grouping window, from the Fields list, double-click a 

field or formula.

The selected field or formula moves to the Group by list.

19. To accept the default properties of the selected fields and formulas, proceed to step 23 on 
page 129.

20. To modify the properties of a group field, from the Group by list, select a field.

21. From the Sort Order list, select a sort order.

22. From the The section will be printed list, select a length of time that defines when the 
group changes.

Note:

This option is available only for Date, Time, and DateTime fields to determine when 
you print the group information. For example, selecting for each hour groups records 
together for each hour, and calculates group summaries for each hour.

23. Click Next.
24. In the Summaries window, from the Fields list, select a field.

25. From the Summation Type list, select a summation type.

As you select the fields in the Fields list, the Summation Type list dynamically updates to 
show the types available for the selected field.

26. From the Groups list, select the check box for each report section in which the summary 
appears on the report.

27. Click Add.

The summary appears in the Summary Data list.

28. Click Next.
29. In the Report Layout window, view or modify the report.

30. On the toolbar, click the Save Report icon.

31. In the Save RCW Report dialog box, choose a folder in which to save the report.
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32. In the Report Name box, enter a name for the report.

33. Click Save.

You can save the report after you select at least one field.

Example of creating an advanced Skillset Threshold report
About this task
An example of creating an advanced Skillset Threshold report.

Procedure
1. In the Report Type window, select the Create Advanced Report (via ODBC) option.

2. Click Next.
3. In the Data Source window, from the DSNs Available list, double-click a CCMS DSN.

The selected DSN is added to the DSNs Selected list.

4. In the Selected DSN Properties area, type the user ID and password to access the data 
source.

For configured servers on the Contact Center Manager Administration server, the user ID 
and password automatically appear.

5. Click Next.
6. In the Table Selection window, from the DSNs list, select the CCMS DSN.

Tables and views for the selected DSN appear in the Tables Available list.

7. From the Tables Available list, double-click dSkillsetStat and Skillset.

The selected tables move to the Tables Selected list.

8. Click Next.
9. In the Table Linking window, from the left Tables list, select iSkillsetStat.

10. From the left Fields list, select SkillsetID.

11. From the right Tables list, select Skillset.
12. From the right Fields list, select SkillsetID.

13. From the Join list, select Left Outer Join.

14. Click Link.

The linked SkillsetIDs appear in the Links list.

The result for the Left Outer Join includes all the records in which the skillsetID in both 
tables match exactly. The Left Outer Join also includes a row for every record in the 
iSkillsetStat table for which the SkillsetID has no match in the Skillset table.

15. Click Next.

Report Creation Wizard

September 2025 Using Avaya Aura® Contact Center Reports and Displays 130
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingAvayaAura%C2%AE%E2%80%8EContactCenterReportsandDisplays&p3=27


16. In the Field Selection window, from the Fields list, under the Skillset Formulas heading, 
double-click RCW_SkillsetNameID.

The selected field moves to the Fields Selected list.

17. From the Fields list, under the iSkillsetStat Formulas heading, double-click 
RCW_ApplicationNameID.

18. From the Fields list, under the dSkillsetStat heading, double-click the following fields:

• Timestamp
• Time
• CallsAnswered
• CallsAnsweredAfterThreshold

19. From the Fields list, under the iSkillsetStat Formulas heading, double-click 
RCW_CallsAnsweredBeforeThreshold.

20. From the Fields list, under the Skillset heading, double-click ServiceLevelThreshold.

21. To modify the Selected Field Properties, in the Fields Selected list, click a field.

22. In the Width box, type a new width.

23. Click Next.
24. In the Grouping window, from the Fields list, select the following fields to group by:

• Skillset Formulas: RCW_SkillsetNameID

• iSkillsetStat Formulas: RCW_ApplicationNameID

• dSkillsetStat heading: Timestamp

Each selected field moves from the Fields list to the Group by list.

25. To modify the Group Field Properties, from the Group by list, select a field, and then from 
the Sort Order list, select Descending Order.

26. Click Next.
27. In the Summaries window, from the Fields list, under the dSkillsetStat heading, select 

CallsAnsweredAfterThreshold.

28. From the Summation Type list, select Sum.

This summation type totals all calls answered after the threshold is reached.

29. From the Groups list, select the following check boxes:

• Report Footer
• Group Footer #1
• Group Footer #2
• Group Footer #3

30. Click Add.
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The CallsAnsweredAfterThreshold field, Sum summation type, and the selected report 
sections appear in the Summary Data list.

31. From the Fields list, under the iSkillsetStat Formulas heading, select 
RCW_CallsAnsweredBeforeThreshold.

32. From the Summation Type list, select Sum.

This summation type totals all calls answered before the threshold is reached.

33. From the Groups list, select the following check boxes:

• Report Footer
• Group Footer #1
• Group Footer #2
• Group Footer #3

34. Click Add.

The RCW_CallsAnsweredBeforeThreshold formula, Sum summation type, and the 
selected report sections appear in the Summary Data list.

35. Click Next.
36. In the Report Layout window, double-click the Page Header section.

37. In the Page Header section, click Time.

38. On the Object Properties page, in the Height box, type 80.

With a height of 80 pixels, the full text can print.

39. Select the Bold and Underline check boxes.

40. In the Page Header section, click the next field.

41. On the Object Properties page, in the Title box, change the title.

For example, change CallsAnswered to Calls Answered, and change 
RCW_CallsAnsweredBeforeThreshold to Calls Answered Before Threshold.

42. In the Height box, type 80.

43. Select the Bold and Underline check boxes.

44. Repeat step 40 on page 132 to step 43 on page 132 for the remaining Page Header fields.

45. Double-click the Group Header #1 section.

46. In the Group Header #1 section, click RCW_SkillsetNameID.

47. On the Object Properties page, in the Width box, type 300.

48. Select the Bold check box.

49. Double-click the Group Header #2 section.

50. In the Group Header #2 section, click RCW_ApplicationNameID.

Report Creation Wizard

September 2025 Using Avaya Aura® Contact Center Reports and Displays 132
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingAvayaAura%C2%AE%E2%80%8EContactCenterReportsandDisplays&p3=27


51. On the Object Properties page, in the Width box, type 300.

52. Select the Bold check box.

53. Double-click the Group Header #3 section.

54. In the Group Header #3 section, click Timestamp.

55. On the Object Properties page, click Remove.

56. Click the Formulas tab.

57. On the Formulas page, under the iSkillsetStat Formulas heading, click 
RCW_Timestamp.

The RCW_Timestamp is a dynamic formula that displays the data range and timestamp 
that you select when you import the report to Historical Reporting. Since this formula 
requires input from Historical Reporting, the results are not exact in the report preview in 
the Report Creation Wizard.

58. Click Add.

The RCW_Timestamp is added to the Group Header #3 section and the Object 
Properties page appears.

59. On the Object Properties page, in the Width box, type 300.

60. Select the Bold check box.

61. On the Object Properties page, select the Bold check box for all fields in the following 
report sections:

• Group Footer #1
• Group Footer #2
• Group Footer #3
• Report Footer

62. On the toolbar, click the Save Report icon.

63. Select the folder in which to save the report.

64. In the Report Name box, type Skillset Threshold.

65. Click Save.

Creating an integrated report
Before you begin

• Start Report Creation Wizard. See Starting Report Creation Wizard on page 120.

About this task
You must create an integrated report to run integrated Contact Summary reports.
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Procedure
1. In the Report Type window, select Create Advanced Report (via ODBC).
2. Select the configured CCMS ODBC DSN.

3. Select the required integrated view.

4. Select view columns and format the report.

5. On the toolbar, click Save Report.
6. On the toolbar, click Import to Historical Reporting.

Saving a report
Before you begin

• Create a report.
• Select at least one field when you create the report.

About this task
Save a report after you modify it.

Procedure
1. On the toolbar, click the Save Report icon.

2. In the Save RCW Report dialog box, choose a folder in which to save the report.

3. In the Report Name box, enter a name for the report.

4. Click Save.

Previewing a report
Before you begin

• Select fields.
• Save the report.

About this task
Click the Preview button to start the Report Viewer.
The Report Viewer supports standard features such as, export, print, and search.

Procedure
1. On the toolbar, click Preview Report.
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2. If the report contains any DateTime fields, the Preview Data filter dialog box appears.

If the report does not contain any DateTime fields, the RCW Report Preview appears.

3. On the Preview Data filter dialog box, select the Start date at and End Date at values.

4. Enter a time in the Start time at and End time at fields.

5. On the Preview Data filter dialog box, click Preview.

The RCW Report Preview appears.

Deleting a report
About this task
Delete a report that you no longer require.

Before you begin
Start Report Creation Wizard. See Starting Report Creation Wizard on page 120.

Procedure
1. On the toolbar, click the Delete RCW Template button.

2. In the Delete RCW Template dialog box, select one or more templates.

3. Click Delete.

Importing a report to Historical reporting
About this task
Before you can run and schedule a Report Creation Wizard report in Contact Center Manager 
Administration, you must save and import the report to Historical reporting. You can use the 
Import tool to import a Report Creation Wizard report into a standard group or into your private 
folder. After you import a Report Creation Wizard report, the system automatically identifies the 
supported data ranges (Interval, Daily, Weekly, and Monthly) during the import procedure.
You can import Report Creation Wizard reports to Contact Center Manager Server only.
Unlike user-imported reports, you need not synchronize Report Creation Wizard reports. After 
you import a Report Creation Wizard report, you can edit the report directly through the Report 
Creation Wizard. After you save the report, all changes are effective immediately.
The procedure to import advanced (ODBC) reports is similar to simplified reports, except for the 
following:

• You must manually enter the supported data ranges for each table referenced in the report.
• You must specify the report type.
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Procedure
1. On the toolbar, click the Import to Historical Reporting icon.

2. In the Import window, in the Report Title box, type the name for the report.

The name appears in Historical Reporting.

3. Click Browse.

4. In the Open RCW Report dialog box, browse to and select the report to import.

5. Click Open.

The Open RCW Report dialog box closes and the path appears in the Location box.

6. From the Time zone list, select the time zone the report uses as the default time zone.

Note:

Avaya recommends that you use the Client Timezone setting. This setting 
automatically adjusts the report interval based on the client time zone.

7. In the Comment box, type additional information about the report.

8. Click the Report Options header.

9. In the Report Options section, select a Report Mode. The options are Standard or 
Private. The Report Mode determines whether the report imports to a standard or private 
folder location.

10. For advanced reports only: From the Report Type list, select a report type.

11. From the Report Group list, select the standard report folder into which you import the 
report. For private reports, you import the report into your private folder.

12. In the Select Server list, select the servers to which to import the report.

13. Click the Data Range header.

14. If you import a simplified report, in the Data Range section, select the Interval Modes for 
which this report is generated, and then proceed to step 18. on page 137

15. If you import an advanced (ODBC) report, from the Table Alias list, select a table.

16. In the Table box, for the data range that matches the selected Table Alias time period, type 
the table name.

17. In the Timestamp box, for the data range that matches the selected Table Alias time 
period, type the name of the field.

For example, if report is based on the iSkillsetStat table alias, the entries for each data 
range appears in the following table:

Interval Mode Table Name Timestamp
Interval iSkillsetStat Timestamp
Daily dSkillsetStat Timestamp

Table continues…
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Interval Mode Table Name Timestamp
Weekly wSkillsetStat Timestamp
Monthly mSkillsetStat Timestamp

18. Click Import.

Example of importing the simplified Agent By Skillset 
Performance report to Historical Reporting

Procedure
1. On the toolbar, click the Import to Historical Reporting icon.

2. In the Import window, click Browse.

3. In the Open RCW Report window, click Agent By Skillset Performance.

4. Click Open.

The Open RCW Report window closes. The information in the Location box appears.

5. In the Report Title box, type Agent By Skillset.

6. From the Time zone list, select the time zone of the server to which to import the report.

Note:

Avaya recommends that you use the Server Timezone default setting. This setting 
automatically adjusts the report interval based on the server time zone.

7. In the Comment box, type additional information about the report.

8. Click the Report Options header.

9. For the Report Mode, select Private.

The Private Report Templates folder is automatically selected as the Report Group.

10. In the Select Server list, select the servers to which to import the report.

The Report Type is automatically selected based on the report definition. This field is 
read-only.

11. Click the Data Range header.

12. In the Data Range section, select all the Interval Mode check boxes to run the report for 
all time frames.

The Table and Timestamp boxes auto-populate based on the report definition and are 
read-only.

13. Click Import.

A message appears at the bottom of the import window stating “Report: Agent By 
Skillset imported successfully.”
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Example of importing the advanced Skillset Threshold report to 
Historical Reporting

Procedure
1. On the toolbar, click the Import to Historical Reporting icon.

2. In the Import window, in the Report Title box, type Skillset Threshold Report.

3. Click Browse.

4. In the Open RCW Report window, browse to the report location for the Skillset Threshold 
report.

5. Click Open.

The Open RCW Report window closes. The information in the Location box populates.

6. From the Time zone list, select the time zone of the server to which to import the report.

Note:

Avaya recommends that you use the Server Time zone default setting. This setting 
automatically adjusts the report interval based on the server time zone.

7. In the Comment box, type additional information about the report.

8. Click the Report Options header.

9. For the Report Type, select HistoricalNodal.
10. From the Select Server list, select the servers to which to import the report.

11. Click the Data Range header.

12. From the Table Alias list, select iSkillsetStat.
13. In the Table and Timestamp boxes, type the following for each Interval Mode.

Interval Mode Table Name Timestamp
Interval iSkillsetStat Timestamp
Daily dSkillsetStat Timestamp
Weekly wSkillsetStat Timestamp
Monthly mSkillsetStat Timestamp

14. Select all the Interval Mode check boxes.

15. Click Import.

A message appears at the bottom of the import window stating “Report: Agent By Skillset 
imported successfully.”
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Defining configuration settings
Before you begin

• Open a saved report in Report Creation Wizard.

About this task
Use the Configuration Settings window to define the default properties for the report.

Procedure
1. On the toolbar, click the Configuration icon.

2. In the Configuration Settings window, in the Report Layout section, select Portrait or 
Landscape.

3. From the Default Font list, select a default font to apply to fields, formulas, labels, or 
added summaries to a report section.

Variable definitions
Variable Definition
Report Layout Page orientation for the report: Portrait or 

Landscape.
Default Font Select a default font to apply to fields, formulas, 

labels, or summaries added to a report section. 
The fonts installed on the Contact Center Manager 
Administration server determine the available fonts.

The previously selected default font still applies to 
objects added before you select the new default 
font. If a font installed on the Contact Center 
Manager Administration server does not appear 
in the font list, it can be because the installed 
font has failed to meet certain requirements. For 
more information, see Troubleshooting Avaya Aura®

Contact Center.

Defining selection criteria
Before you begin

• Import a Report Creation Wizard report to Historical Reporting. See Importing a report to 
Historical reporting on page 135.

• Log on to Historical Reporting.

Defining configuration settings
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About this task
Define selection criteria to determine the entities to include in a report. The following options are 
available when you define a Report Creation Wizard report in Historical Reporting:

• Define the selection criteria.
• Schedule to print the report.
• Schedule to send the report to a file.
• Save the report.
• Run the report immediately.

You define the selection criteria for Report Creation Wizard reports differently than you do for 
user-defined reports.

Procedure
1. In the left pane, click the server under which the Report Creation Wizard report is stored.

2. Navigate to the Report Creation Wizard report.

3. In the Report Properties window, click Selection Criteria.

The Selection Criteria heading expands. The fields of each selected Report Creation 
Wizard table appear in the fields list.

4. From the fields list, select a field.

The table name and the field data type appear in the criteria list.

5. From the criteria list, select one of the following values:

• Is equal to: If you select Is equal to, you can filter the selected field based on only one 
element. You can base the filter on a field from the tables that you include on the report, 
including fields that you did not select on the report.

• Is greater than
• Is less than
• Not equal to
• Between
• In: If you select In, you can filter the selected field based on multiple elements. You can 

base the filter on a field from the tables that you include on the report, including fields 
that you did not select on the report.

• Starts with
• Contains
• Ends with

The field data type determines the values available in the criteria list.

6. Click the ellipsis (...).
7. From the Select Elements dialog box, select a field value.
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If you select In from the criteria list, you can select multiple elements.

8. To select all elements, select the Select All check box.

9. Click Choose.

The Select Elements dialog box closes, and the selected field value appears in field value 
box.

10. Click Add.

The selection criterion appears in the Selection Criteria list.

11. To define additional selection criteria, from the join list, select AND or OR, and then repeat 
step 4 on page 140 to step 10 on page 141.

Moving a field
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
The column headings in the Page Header section link to the fields in the Details section. If you 
move a field in the Details section, the heading associated with this field moves.

Procedure
1. To move a field, perform one of the following activities:

• Click a field, hold down the left mouse button, and drag to the object.

• Highlight the object and use the up, down, left, and right arrow keys to move the object.

2. Click Save.

Resizing an object
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
To customize an object, you can modify the object size.

Moving a field
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Procedure
1. To resize an object, perform one of the following activities:

• Move the mouse to the end of the object outline, after the cursor changes to a resize 
cursor, hold down the left mouse button, and drag to increase or decrease the size of 
the object.

• Highlight the object, hold down the Ctrl key and use the left and right arrow keys to 
resize the object.

2. Click Save.

Adding a text field
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
Add a text field If necessary.

Procedure
1. Click a section in the Report View area.

2. Click the Add Text Object icon on the toolbar.

A new text field is added to the selected section.

Modifying object properties
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard and navigate to 
the Report Layout Window.

• Ensure that you are familiar with the Report Layout Window.

About this task
Use the Object Properties tab in the Report Layout window to modify group, field, or formula 
properties.

Procedure
1. Select a report section.

The selected report section expands to reveal fields and formulas.

Report Creation Wizard
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2. Select a field in a section to display the field properties in the properties bar.

The selected field appears with a yellow background.

3. Click the Object Properties tab.

4. Modify object properties.

5. Click Submit to save changes.

The updated field appears in the report view area.

6. Click Save.

Variable definitions
Variable Definition
Title Type the field name. The name appears on the 

report.
Height Type a numeric value for the field height in pixels.
Width Type a numeric value for the field width in pixels.
Left Type a numeric value for the horizontal position 

of the field on the report. The value you enter 
represents the number of pixels from the left margin 
that the field is placed on the report.

Top Type a numeric value for the vertical position of the 
field on the report. The value you enter represents 
the number of pixels from the top margin that the 
field is placed on the report.

Format Select a time or number format. The Format 
property is available only if you select a number, 
currency, Date, or Time data type object.

Currency Select a currency type. The Currency property is 
available only when you select a currency data type 
object.

Font Select a font type. The font type appears on the 
report for the selected field. The fonts installed on 
the Contact Center Manager Administration server 
determine the available fonts.

Note:

If an installed font on the Contact Center 
Manager Administration server does not 
appear in the font list, it can be because 
the installed font has failed to meet certain 
requirements.

Font Color Select the font color to appear on the report for the 
selected field.

Table continues…

Modifying object properties
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Variable Definition
Font Size Select the font size to appear on the report for the 

selected field.
Text Align Select one of the following: Right, Left, or Center. 

This represents the field text placement within the 
field.

Bold Apply bold to the field text that appears on the 
report.

Italic Italicize the field text that appears on the report.
Underline Underline the field text that appears on the report.
Suppress Suppress or hide the field on the report.

Suppressing a report section
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
Suppress sections to exclude the sections from the printed report.

Procedure
1. In the Report Layout window, select the section header to suppress.

The selected header appears in a color different from the others.

2. Select the Section Properties tab.

3. On the Section Properties page, select the Suppress check box.

The section header color changes to light grey.

4. Click Save.

Adding or removing a field in a report
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
In the Fields tab, add fields or remove fields to modify a report.

Report Creation Wizard
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Procedure
1. In the Report Layout window, select the section header to which to add a field.

2. Click the Fields tab.

3. On the Fields page, select the field.

4. To add the field, click Add.

If you add a field to the Details section of the report, the Report Creation Wizard adds 
a corresponding text heading to the Page Header section of the report. If you move that 
field, the heading also moves so that it remains horizontally aligned with the field.

5. To remove the field, click Remove.

Note:

If you remove a field from the Field Selection page, the field is removed only from the 
Details section, not from any other section.

6. Click Save.

Adding or removing a formula in a report
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
Add formulas or remove formulas to update a report. Formulas appear under the relevant 
headings in the Formulas list. Standard formulas appear under the Formulas heading. 
Formulas relating to views appear under separate headings for each view, for example, 
iAgentPerformanceStat formulas. Report formulas, and formulas that appear on the report and 
have no association with a Report Creation Wizard formula, appear in the Formulas list.
If you add a formula to the Details section of the report, a corresponding text heading appears in 
the Page Header section of the report. If you subsequently move the formula, the heading moves 
so that it remains horizontally aligned with the field. If you remove the field, you automatically 
delete the heading from the Page Header section.

Procedure
1. In the Report Layout window, select the section header to which to add a formula.

2. Click the Formulas tab.

3. On the Formulas page, select the formula.

4. To add the formula, click Add.

5. To remove the formula, click Remove.

Adding or removing a formula in a report
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6. Click Save.

Sorting the direction of a group, field, or formula
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.

About this task
Use the Sorting tab to select the sort direction of a returned group, field, and formula data on the 
report.

Procedure
1. In the Report Layout window, click the Sorting tab.

2. To sort the direction of a group, on the Sorting page, click the Groups heading.

3. To sort the direction of a field or formula, click the Fields heading.

4. Select the group, field, or formula for which you want to change sort direction.

5. Select one of the following sort direction options:

• Ascending
• Descending
• Original Order (for Groups) or None (for Fields)

6. Click Save.

Sorting the order of a field or formula
Before you begin

• Open an existing Report Creation Wizard report in Report Creation Wizard.
• Ensure that you are familiar with the Report Layout Window.
• Assign a sort order to the selected field or formula. See Sorting the direction of a group, field, 

or formula on page 146.

About this task
Use the Sorting tab in the Report Layout window to select the sort direction of field and formula 
data on the report.

Procedure
1. In the Report Layout window, click the Sorting tab.
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2. On the Sorting page, click the Fields heading.

The heading expands to reveal selected fields and formulas for the report.

3. Click the field or formula for which you want to change the sort order.

4. Use the up and down arrows to change the sort order for the selected field or formula.

Group sorts always appear first, followed by field and formula sorts.

5. Click Save.

Editing a Report Creation Wizard report in Historical 
reporting

Before you begin
• Create a report in Report Creation Wizard. See Creating a simplified report on page 121 or 

Creating an advanced report on page 127.
• Import the report to Historical reporting. See Importing a report to Historical reporting on 

page 135.
• Log on to Historical Reporting.

About this task
To modify a saved Report Creation Wizard report, access Historical reporting.

Procedure
1. In the left pane, click the server to which you want to log on.

2. Navigate to the folder in which the Report Creation Wizard report to edit is stored.

The report icon for a Report Creation Wizard report is different from the report icon for a 
standard report.

3. Right-click the report, and then click Edit.

The report appears in Report Creation Wizard in the Report Layout window. All buttons in 
the navigation bar and the toolbar are enabled.

4. Edit the report.

5. On the toolbar, click Save.

All changes are effective immediately.

Editing a Report Creation Wizard report in Historical reporting
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Applying template changes to existing reports
Before you begin

• Log on to Report Creation Wizard. See Starting Report Creation Wizard on page 120.

About this task
Existing reports do not automatically receive the changes you make to report templates; therefore, 
you must apply the template to each report.

Procedure
1. Open the report in Report Creation Wizard.

2. Click the Configuration icon.

3. Change the Report Layout.

If the current setting is Landscape, change it to Portrait. If the current setting is Portrait, 
change it to Landscape.

4. Click Close.

5. Click the Configuration icon.

6. Change the Report Layout back to the original setting.

7. Click Close.

8. Click the Preview icon to confirm that the applied changes.

9. Click Save.

Report Creation Wizard
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Chapter 14: External database server 
configuration

Contact Center Manager Administration (CCMA) reports can pull data from Contact Center Manager 
Server, from Contact Center Multimedia, and from external databases in Avaya applications that 
complement the contact center solution.

End users shall use Contact Center Manager Administration to create and modify report files which 
are viewed with CCMA and all reports shall contain only Avaya application data. No third party 
data sources can be accessed within CCMA to create and modify reports in conjunction with Avaya 
Aura® Contact Center data.

For example, you can use data in an Avaya Experience Platform™ Workforce Engagement database 
to include in Avaya Aura® Contact Center agent reports.

You must complete all the procedures in this section in sequential order.

Prerequisites to external database server configuration
• Ensure that you have a license for Report Creation Wizard.

• Install Report Creation Wizard.

Configuring and testing the ODBC driver
Before you begin

• Verify that the database type and version are supported.
• Determine the IP address or host name for the server that is hosting the database.
• Identify the database name, user ID and password for the database.

About this task
Use the following steps to obtain, install, and configure the ODBC driver for the external database 
type and version.
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The Contact Center Manager Administration installation includes the following ODBC drivers:
• InterSystems Cache 2009.1 connects to the Contact Center Manager Server, Contact Center 

Manager Administration, and Contact Center Multimedia databases.
• Sybase Adaptive Server Enterprise (ASE) version 12.5 connects to previous versions of the 

Contact Center Manager Server database.
If one of these installed drivers supports your external database, you do not need to install 
additional database drivers.

Procedure
1. Obtain the ODBC driver for the database type and version from the database vendor.

2. Install the ODBC driver on the Contact Center Manager Administration server.

Note:

If the driver is already installed, you do not need to install additional database drivers.

3. Click Start > All Programs > Administrative Tools > Data Sources (ODBC) to start the 
administration tool for the ODBC driver.

The system creates a 64–bit ODBC DSN.

For 32 bit ODBC DSN, the path is: C:\Windows\SysWOW64\ODBCAD32.exe.

4. Configure the ODBC DSN in the format <Prefix>_<IP address>_DSN, where <Prefix> is 
used to configure the database server within the CCMA configuration application, and <IP 
address> is the address of the external database server.

5. Using the ODBC Data Source Administrator tool, test the DSN for connectivity to the 
database.

Verifying external databases in Report Creation Wizard
Before you begin

• On the Contact Center Manager Administration server, configure the ODBC DSN for the 
external database. For more information, see Configuring and testing the ODBC driver on 
page 149.

• Know the user ID and password for the database data source name (DSN).

About this task
Test the ODBC DSN using Report Creation Wizard (RCW) to ensure that RCW can connect to the 
database successfully.

Procedure
1. Log on to Contact Center Manager Administration.

2. On the Launchpad, click Historical Reporting.

External database server configuration
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3. In the left pane, right-click the Contact Center Manager Server from which you access the 
database.

4. In Historical Reporting, on the Report menu, select Report Creation Wizard.

5. Select the option to Create Advanced Report (via ODBC).
6. Click Next.
7. On the Data Source page, from the DSNs Available list, double-click the external ODBC 

DSN entry to move it to the DSNs Selected list.

8. Enter the user ID and password details for the DSN.

9. Click Next.
10. In the Tables Available list, verify the list of tables and views are correct for the DSN.

11. In the Tables Available list, double-click a table to move it to the Tables Selected list.

12. Click Next.
13. In the Fields box, double-click the field names that you want to appear in the report. Move 

them to the Fields Selected list.

14. Click Preview on the toolbar to view the report.

If a Report preview appears, the ODBC DSN is compatible with the Report Creation 
Wizard.

15. Save the report using the Report Creation Wizard as TestReport.rdl.

Adding the external database server to Contact Center 
Manager Administration

Before you begin
• Verify the external database against the Report Creation Wizard. For more information, see 

Verifying external databases in Report Creation Wizard on page 150.

About this task
Verify that the Historical Reporting component of Contact Center Manager Administration can 
support the data extracted from the external database.

Procedure
1. In Contact Center Manager Administration, click Configuration.

2. Click Add Server.
3. Select Other.
4. In the DSN Prefix box, type the prefix you created in Configuring and testing the ODBC 

driver on page 149.

Adding the external database server to Contact Center Manager Administration
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Note:

Remember that the DSN prefix is case sensitive.

5. Click Submit.

Associating an external server to a Contact Center 
Manager Server

Before you begin
• Add the external database server to Contact Center Manager Administration.

About this task
Associate a external database server to a Contact Center Manager Server. When you want to 
access historical reports for the external database, you must choose the selected Contact Center 
Manager Server.

Procedure
1. On the Launchpad, click Configuration.

2. In the left pane, right-click the Contact Center Manager Server to associate with a reporting 
server.

3. Choose Server > Edit Properties.

The properties for the Contact Center Manager Server appear in the right pane.

4. In the Associated Reporting Server list, select the reporting servers to associate to this 
Contact Center Manager Server.

5. Click Submit to save your changes.

Importing Report Creation Wizard reports to historical 
reporting

Before you begin
• Create a report from the external database using the Report Creation Wizard. For more 

information, see Verifying external databases in Report Creation Wizard on page 150.

About this task
Import the Report Creation Wizard report you created from the external database into Historical 
Reporting to verify that a historical report in Avaya Aura® Contact Center can be generated.

External database server configuration

September 2025 Using Avaya Aura® Contact Center Reports and Displays 152
Comments on this document? 

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=UsingAvayaAura%C2%AE%E2%80%8EContactCenterReportsandDisplays&p3=27


Procedure
1. Open the Report Creation Wizard. In Historical Reporting, on the Report menu, select 

Report Creation Wizard.

2. Click Import to Historical Reporting on the toolbar to import the report.

3. Browse to the report you saved in Verifying external databases in Report Creation 
Wizard on page 150.

4. Type a title of the report.

The title appears in the list of available reports in the Historical Reporting application.

5. For Report Mode, select Private.

6. In the Report Type box, select a report type.

7. Select the server to import the report.

8. Click Import.

A message appears indicating the report is imported successfully.

Generating historical reports from an external database
Before you begin

• Import the Report Creation Wizard report. For more information, see Importing Report 
Creation Wizard reports to historical reporting on page 152.

About this task
Update and generate the historical report using the Report Creation Wizard to gather data from 
a external database. The external database is associated with a Contact Center Manager Server 
and is tested for connectivity.

Procedure
1. On the CCMA Launchpad, click Historical Reporting. If the Historical Reporting page is 

already open, click Refresh.

2. In the left pane, right-click the Contact Center Manager Server where you access the 
database.

3. Open the Private Reports folder.

4. Select the imported report.

5. Under Selection Criteria, choose the fields you want to appear in the report.

6. If data is available in the Browse dialog box, select an item and add this to the selection 
criteria for the report.

7. Run the report.

Generating historical reports from an external database
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8. Verify the report runs successfully with the new selection criteria.
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